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1 FOREWORD

This programmer's manual describes the operating software metimus, an
external test program editor for the use with the vision systems (intelligent
cameras pictor metimus) by Vision & Control GmbH.

In this manual, the use of the operating software metimus and the most
important functions are described.

The available functionality depends on the the vision system that is used. This
document describes the options for full function scope.

Please refer to the instructions of use for more detailed information about the
vision systems.

As well as the software, this programmer's manual is regularly improved and
extended. The current version can be found on the home page of Vision &
Control GmbH under www.vision-control.com.

http://www.vision-control.com/
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2 THESE INSTRUCTIONS OF USE

We recommend introductory training at the Vision Academy. Before you start
writing your own programs you should be familiar with the way the software
works. The instructions of use provide a good basis.

Using the table of contents at the beginning or the index at the end of the
manual you will quickly find the menu item or command that you want to know
more.

Part 1 – Introduction The chapter Introduction to the Operating Software ("Introduction to the
Operating Software", Page 8) describes the function, the scope of the
program and other basic features of the operating software. Use this chapter to
get an overview of the operating software.

In the following chapter Install and Start the Operating Software ("Installing,
Starting and Updating metimus-Operating Software", Page 9) you will
be guided step by step through the installation and the first execution of the
operating software.

Part 2 – User Interface
and First Steps

The First Steps chapter ("First Steps", Page 10) describes how to connect
the operating software to the vision system and calibrate the device using the
user interface.

The next section Working with the User Interface ("Working with the User
Interface", Page 15) explains the principles of working with the operating
software and the individual program elements. The following subchapters
explain all menu items in the order of their position in the respective menu, as
well as the toolbars and other interface elements.

Part 3 – Introduction
to Functions and
Function Reference

The section Introduction to Functions ("Functions", Page 42) explains
the procedure for setting up functions and illustrates the progress and the
functionality of a test program.

The chapter Function Reference ("Function Reference", Page 51) briefly
describes the available functions and the respective parameters step by step.

The chapter Output ("Output", Page 104) explains the typing and sending of
test results.

Part 4 – Appendices In the Appendix ("Part 4 - Appendices", Page 107) you will find a small
overview of the most important terms in image processing as well as
descriptions of the measured value file, special protocols and algorithms.

Additional
Instructions of Use

When purchasing a vision system from the manufacturer Vision & Control
GmbH, you will receive an Instruction of Use. This document describes the
resources available for the vision system.
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3 TERMS AND SYMBOLS

The terms and symbols in this manual help you to use the instructions for use
and the operating software quickly and safely.

Advice ADVICE
Indicates tips for use and useful additional information. This does not expel
any dangerous or harmful situation.

Enumeration Indicates a listing of issues or possibilities:

• Example Enumeration 1
• Example Enumeration 2

Operating steps List of operating steps. For the numbered action steps, the sequence must be
observed and the numbering starts with 1. for each individual sequence.

1. Example action step 1

2. Example action step 2

The alphabetical action steps describe alternatives in the action sequence.

a) Example alternative A
b) Example alternative B

Cross-references Cross-references help you to make quick reference to particular sections of the
manual, providing valuable supplements of information. The cross-reference
shows you the page of the relevant section.

Example: see "These Instructions of Use", Page 6

Links Links lead to documents outside the instructions for use. Expressly, no
guarantee or liability is accepted for the accuracy and security of these
documents (such as Internet pages). Links are only active in online-help and the
PDF version and with a connection to the Internet.

Example: www.vision-control.com

Images and Tables Images and tables have sequential numbering, which are identified as such.
Within illustrations, individual details are marked with position numbers and
position lines. The item numbers are explained in a caption.

Notations Commands, menus and dialogues are highlighted in bold. References to
subordinate entries are indicated by arrows. The spelling Image > Capture
Image describes the command Capture Image in the Image menu.

Buttons are marked with square brackets. [Test] indicates to the Test button.

http://www.vision-control.com/
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4 PART 1 - INTRODUCTION

The operating software metimus is an external test program editor for the vision
systems (Intelligent Cameras pictor metimus) supplied by Vision & Control
GmbH.

Use metimus to create, modify, test and start test programs.

metimus runs under Windows.

Previous Experience You should be familiar with the operation of Windows programs. Programming
experience is not required. Before you start, you should be familiar with the
operating software and the sample programs supplied.

Available Functions The user interface only offers those functions that are supported by your vision
system. If you do not have authorization for certain functions or commands (see
"Manage Logins", Page 21), they are greyed out.

Available Languages The user interface can be switched between English and German.

4.1 Introduction to the Operating Software

Communicating with
Vision Systems

PC

vision system
pictor metimus

exteral module
PLC, slave, master

edit test programs

Monitoring

Send results

ethernet
digital I/O
field busses

operating software
metimus

test program

Image 1: Communication model - pictor metimus - external modules

Communicating withPLC Devices

The vision system can also be connected via the signal I/O port, ethernet or
fieldbus interface to Programmable Logic Control devices (PLC). The PLCs
send or request event data and can thus be integrated into the test runs. Direct
control of actuators is also possible.
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4.2 System Requirements

Minimum
requirements of the
computer

• Operating systems: Windows 7, Windows 8, Windows 8.1, Windows 10 
- Both 32 and 64 bit versions (Windows RT is not supported)

• DVD drive (for installation from DVD) or Internet connection (for installation
after download)

• Minimum 1 GB free RAM
• Ethernet interface

4.3 Installing, Starting and Updating metimus-Operating Software

Installing ADVICE
Administrator rights are required to install the Operating Software.

The device pictor metimus is supported from the operating software version
metimus 1.7.0.

1. Insert the supplied DVD into the drive of the host computer

2. Select the folder "Software".

3. Select the metimus-Operating Software and install on the computer by
double-click. Follow the instructions given by the installation program, and
change the target directory if desired.

The software also installs an optional icon on the Windows Desktop, and
creates entries in the start menu.

Starting The Operating Software can be started by double-clicking the icon on the
Desktop or by selecting it from the start menu. Registration is not required.

Updating The software version which is current at the time of delivery is always supplied
with the device. There is no automatic update.

New versions of the metimus-Operating Software can be downloaded from:
www.vision-control.com.

http://www.vision-control.com/
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5 PART 2 - FIRST STEPS AND USER INTERFACE

5.1 First Steps

5.1.1 Set up connection

Select device To be able to use the full functional scope of the User Interface you must first
connect the program with a connected vision system. If you do not have a vision
system yet, you can connect an implemented simulator, a 'virtual camera'.

The Simulator incorporates a large part of the functionality of the vision system.
A test pattern implemented by default (also as a set-up aid, see "Testpattern",
Page 120) as camera image and the ability to upload and test images (see
"Load image from PC", Page 26) make integration easier and optimise
the simulator for test purposes. The simulator can be available for selection
in different versions. The respective simulator's range of functions is based
here on the real device with the respective firmware version. If you want to
use the simulator to create and test "test" programs for your vision system,
for compatibility reasons you should use the simulator that is closest to your
firmware version.

Compared with a vision system the simulator can not

• capture any images,
• send any live images,
• issue digital signals,
• use RS232,
• use any external triggers.

The simulator's processing times with test processes are not the same as those
of a vision system. Depending on the host computer, the simulator is quicker at
processing.

Set up a connection
as follows

ADVICE
Before connecting with the vision system ensure that it is correctly connected
to the host computer.

1. Click in the toolbar beside Connect in the selection list.

2. Choose a device.
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a) Select from the drop-down list the vision system with which you want to
connect the user interface.

b) If you want to manually add and connect a vision system because that is
in another subnet (behind a router) and is therefore not displayed in the
drop-down list, click Add Network Device. Then assign a name for the
device and optionally enter an IP address. The device is then displayed in
the toolbar.
For more information on managing network devices, please refer to the
section see "Manage Network Devices", Page 29.

3. Click in the toolbar on Connect.

The user interface is now connected with the vision system or the simulator.

5.1.2 Calibrating the device 

Via the Calibration in the user interface you can set the scale between image
coordinates (pixels) and global coordinates (mm, cm, etc.); the "calibration
factor". This is then recorded and saved in the X-pixel value and the Y-pixel
value. On one hand the calibration of the vision system with individual lens is
required because individual lenses produces various image field values and
therefore pixel values. On the other hand you can also calibrate a simulator
to adjust created or changed test programs to the respective calibration of the
"real" device.

ADVICE
Shutter and lighting settings are controlled separately with the calibration. You
can set these with the Calibrate view in the Camera tab. These values are
saved with the calibration factors in the camera.

The determined calibration factor is accepted for both the device used and for
the currently active program. To also keep the calibration after closing the user
interface you must save it in the program (Menu File > Save on Device) and/or
in the device Menu Device > Save Device Settings). If a program's calibration
is different to that of a device (e.g. when opening an old program with a recently
calibrated device), you are asked in a dialogue box if you want to transfer the
program's calibration to the device (e.g. to transfer the calibration data from the
real sensor to a simulator). You can always decide which calibration you want to
work with. When you create a new program a calibration of the sensor is used
automatically.

You can calibrate by manually entering the image field values or even using
one of the measuring functions (caliper, edge position, measure circle) and an
exemplary calibration piece.
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ADVICE
Every calibration process is saved in a separate log as an individual test
result. An own function ID is used here for the caliper, edge position and
measure circle calibration functions, which differs from the respective test
function (see "Description of the measured value file", Page 112).

As soon as you make a change in the Calibration view the existing log is
deleted.

Calibrate via image
field size

This calibration process gives the user the ability to calibrate the device via
direct value entry of the image field size. The calibration factor and ultimately
the pixel values are calculated from this. The camera's x-direction and y-
direction are calibrated separately, as different calibration factors are possible
horizontally and vertically depending on the pixel geometry.

ADVICE
Lens distortion can cause inaccurate image field size calibration. The
accuracy depends on the lens used.

Depending on feasibility, for the vision system it is recommended you calibrate
via the measuring functions to get more accurate and object-specific results.

Steps

1. To go to the calibration view click in the
menu bar on View > Calibration.

2. Click in the tab area on the camera index
card and configure the lighting settings and
the shutter. Change to the Calibrate index
card and then to the drop-down menu in
the Function area. Select Field of view.

The parameter area appears.

3. Enter your device's image field dimensions
in the value fields.

4. Click on Calibrate.

In the results area the calibration is displayed as an individual function
test with the values for the X-pixel size and the Y-pixel size.

5. Save the calibration as you want in the
device under Device > Save device
settings and/or in the program under File
> Save on device.

Calibrate via
measuring functions

In addition to the image field size you can also calibrate the three measuring
functions and an exemplary calibration piece. The caliper (see "Caliper",
Page 81), edge position (see "Edge position", Page 74) and measure
circle (see "Measure circle", Page 99) functions are available, all of which
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are identical in their measuring process with the respective test functions. Using
a definable reference value for the measured distance and the measured radius
in global coordinates, the calibration factor is calculated via the found pixel
number and issued in the X-pixel size and Y-pixel size.

Practical notes for calibrating

• Where possible, for calibrating use the function with which you later also
want to test your test object.

• The shape and size of the calibration piece should correspond with the later
test object.

• Where possible use the same detection parameters that you also use for the
test function.

• Ensure even, homogeneous lighting by configuring accordingly on the
camera tab.

Steps

1. To go to the calibration view click in the
menu bar on View > Calibration.

2. Click on the Calibrate index card in the
tab area and then on the drop-down menu
in the Function area. Select the func-
tion you want: caliper, edge position,
measure circle.

The parameter area appears.

3. Parameter the function as described in the respective sections, caliper (see
"Steps for setting up the Caliper function", Page 88, steps 2 - 6), edge
position(see "Steps for setting up the Edge position function", Page 80,
steps 2 - 6) or measure circle (see "Steps for setting up the Measure circle
function", Page 103, steps 2 - 5).

4. Define the reference value for the selected
distance and the selected radius under
distance reference value and reference
radius

5. Click on Calibrateto check the parameters' settings and to calibrate the
device.

• If applicable edges have been found, the result value of the measure-
ment is shown in pixels and the distance found is shown in blue. The
values for the X-pixel size and Y-pixel size calculated using the calibra-
tion factor are issued in the results area.

• If no edges or unwanted edges are found, correct the corresponding
parameters and/or the detection area. Then click on Calibrate again to
check your changes. Repeat this step as often as necessary.

6. Save the calibration as you want in the
device under Device > Save device
settings and/or in the program under File
> Save on device.
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5.1.3 Configure camera

Exposure time The exposure time is the time that the imager of the vision system is made light-
sensitive for. Via the user interface it can be set and controlled electronically.
The setting is possible via the logarithmic sliding controller, the direct value
entry connected with it or the Auto function.

The Auto function determines an exposure time suitable for the prevailing light
conditions. This exposure value is set automatically by the sensor. Click on
Auto Adjust to activate the Auto function. 

If you want to specify the exposure time manually, activate the Live image
function (see "Live Video", Page 27). You can track and evaluate the effects
of a change in the exposure time in real-time.

• To set the exposure time use the logarithmic sliding controller and slide it
with pressed mouse button to the value you want. Via the text field you can
also enter a value directly, which can then be adjusted via the arrow buttons
on the right side of the field in steps of 1. Entered numerical values are only
first accepted when the Enter button is pressed.

Lighting modes You can select the mode of the lighting of your test object via a drop-down
menu. The following modes are provided:

Mode Status

On The lighting is always on.

Off The lighting is always off.

Automatic (recom-
mended)

The lighting is generally off and is only switched on for the
period of the image recording.

With a low lighting load the Automatic mode prevents a high thermal load and
therefore extends the LEDs' service life and saves energy.

Outputs for Lighting

Here you can specify which outputs or which interface is to be used for the
lighting. No outputs are reserved as standard.

Under Menu Device > Digital IO Settings you can reserve digital outputs for
the illumination (see "Digital IO settings", Page 22). If you activate one or
more outputs in the Devices menu, the respective output is also displayed in
the camera register and can be selected by you as the lighting output. The
corresponding outputs are then no longer available in the output register and
are crossed out.
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5.2 Working with the User Interface

5.2.1 Structure of the User Interface

User Interface The metimus user interface opens with the default view the first time you start
it. The default view allows, among other things, the setup of a connection to the
machine vision system, the creation of test programs and the parametrization of
commands.

Camera Image Window

Status Bar

Result Area

Menu Bar Toolbar

Parameter Area

Image 2: Elements of the user window

In the default view, the user interface contains the following elements:

Element Description

Menu Bar Here you will find File, View, Device, Image, Tools and
Help menus.

Toolbar Here you will find the most frequently used commands
such as Connect to device (incl. device browser), Live
Video, Capture image, Test All and Disable Image
Capturing.

Camera Image
Window

Here, the current captured / edited image is displayed.
Furthermore, the display of function results can be set
here.

Parameter Area Here you select functions for your test program and
parametrize them.

Result Area Here you see all results belonging to the test, a good/
bad evaluation of the individual commands as well as
the evaluation of the test all. Use the arrow buttons to
switch through all test results to previous images.

Status Bar Here you can see system and program information.

5.2.1.1 Menu Bar

Image 3: Menu Bar
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5.2.1.1.1 Menu File

The menu File contains commands for managing and processing programs.
With programs you can easily combine individual test processes and save them
on both the integrated Flash memory of the vision system and on your PC.

Image 4: Menu File

To open the File menu, click the File command on the menu bar.

Create program 1. Click in the menu bar on File > New.

2. In the text field give the new program a name and confirm with OK.

The new program is created, loaded in the RAM and activated.

Open Program Programs can be either opened on the Flash memory of the vision system
(device) or uploaded externally from the PC. An opened program is
automatically activated and closes the currently active program.

• To open a program click in the menu bar on File and then select one of the
two options to open a program.

a) Open from device
Select the program you want and confirm with [Open].

The selected program is opened and activated.

b) Open from PC 
Select a source directory and then select the program you want. Only
metimus user interface files (*.sp) can be opened. Enter a program name in
the subsequent dialogue box and confirm with [OK].

The selected program now opens, is loaded in the RAM and activated.

Save Program Programs can be either saved in the vision system’s Flash memory (device) or
downloaded externally on the PC. The file format here is *.sp.

• To save a program click in the menu bar on File and then one of the three
possible save functions.

a) Save on device

The current program will be saved on the Flash memory of the vision
system. The program name is used as file name.

b) Save on device as
In the text field enter a file name and confirm with [Save].

The current program will be saved on the Flash memory of the vision
system.
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c) Save on PC as
Enter a file name in the text field, select a directory and then confirm with
[Save].

The current program is now saved on your PC.

Set Programas Start
Program

When you set a program as start program it will be activated and executed with
every new start of the vcwin smart and executed by default.

• To select the currently active program as start program, click in the menu bar
on File > Set as start program..

• Save the device settings afterwards. (Menu: Device > Save device
settings)

Rename Program 1. To give the currently activated program another program name, click in the
menu bar on File > Rename.

2. In the text field enter a program name and confirm with [OK].

Close • To close the user interface, click on File > Close.

5.2.1.1.2 Menu View

Using the View menu you can adapt and optimise the user interface as you
wish. In addition, several preset configurations of the user interface are also
available.

Image 5: Menu View

To open the View menu, click the View command on the menu bar.

Select view The user interface offers you four pre-set views from which you can select.
These are optimised for various image processing task areas and include
corresponding functions and dialogues. The pre-set views can be neither
changed nor deleted.

You can find the pre-set views in the menu bar under the command View in
the upper part of the menu. The "Default" view is active the first time the user
interface is started. When restarting, the last active view is used as the start
view.
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• Click on one of the pre-set views to activate it: Standard, Monitoring, Batch
test, Calibration.

View Specific Features

Default Standard view for parametering functions and creating test
programs.

• Tabs: Camera, Tracking, Functions, Output
• Toolbars: Connect, Test all, Capture Image

Monitoring View for monitoring and changing/activating programs
(very restricted command scope).

• Tabs: Monitoring
• Toolbars: Connect

Batch test View for parametering and evaluating test results with a
test series.

• Tabs: Test series, Tracking, Functions, Output
• Toolbars: Connect, Test all, Capture Image

Calibration View for calibrating the vision system.

• Tabs: Camera, Calibration
• Toolbars: Connect, Capture Image

Table 1: Pre-set views

ADVICE
In the Monitoring view, it is possible to change programs using digital IOs
and process communication even when the graphical user interface is
connected. For other views, the user interface must be disconnected before
changing the program.

Show/hide windows If you have added your own view (see section "Add view"), you can show or
hide single windows or areas for the new view using the Window  menu. You
can choose between Camera, Tracking, Functions, Output, Camera Image,
Results, Monitoring, Batch Test and Calibration. To permanently show or
hide the window in the current view, save the view (see section "Save view").

Add view 1. To create a new custom view, click View > Add View on the menu bar.

2. In the next dialogue box select a source view via the drop-down menu, on
which the new view is to be based and give your view a name in the text
field. Then confirm with [OK].

The new view has been created and can now be processed. The
respective view name is listed in the View menu and marked with a
checkmark on the left (view is currently activated).

For a detailed description of setting up an own view, please read chapter
"Adapting the user interface", Page 35.



metimus 1.7.0.6
Part 2 - First Steps and User Interface

© Vision & Control GmbH
2018

999.994.424.10-en-1.0 19

Save view 1 To save a view click in the menu bar on View and then select one of the two
save functions.

a) Save view

The view is saved under the view name.

b) Save view as
In the text field enter a view name and then confirm with [OK].

The view is saved under the new view name and shown in the menu
view.

ADVICE
The user view is not automatically saved when the program is closed. There
is no prompt at all. The view must therefore first be explicitly saved with Save
view as .

Delete view 1. To delete an own view click in the menu bar on View and then select the
view you want in the top part of the selection list.

2. Now click again in the menu bar on View. Ensure that the view to be deleted
is active (with a check mark beside its name in the selection list). Please
note that only views you have created can be deleted (pre-set views cannot).

3. Click on the command Delete View and confirm the prompt with [OK].

Status Barshow / hide You can show or hide the status bar (see chapter "Status Bar") using the Status
Bar menu item.

5.2.1.1.3 Menu Device

Image 6: Menu Device

To open the Device menu, click the Device command on the menu bar.

All commands in the Device menu refer to the currently connected vision
system



metimus 1.7.0.6
Part 2 - First Steps and User Interface

20 999.994.424.10-en-1.0 © Vision & Control GmbH 2018

ADVICE
When you save changes in the device menu with Device > Save device
settings, these are kept with a program restart. Otherwise you are
informed that you have made device settings and not yet saved them when
disconnecting the device. In this dialogue box you can then decide whether or
not to discard the changes.

Device information You can have the name, serial number, software version, camera resolution,
camera type and current calibration of the connected vision system displayed.

Program manager All programs saved on the Flash memory of vision system and can be viewed
in the Program manager. You can open this with Device > Program manager
. The program manager consists of a table with all available programs and
their respective PLC IDs, buttons for managing the programs and a legend. It
provides the following functions:

• Program status information
At least one program circle identifier is shown in the table in front of a
respective program. The respective meanings of the different colours
are provided in the legend in the bottom part of the window and are also
subsequently explained. The name of the currently active program is shown
in bold.

Colour Meaning Explanation

Saved. The marked program is saved in the
current status.

Not yet saved. The marked program has not yet
been saved in the current status.

Set as startup program. The marked program is currently set
as startup program.
This program status identifier can
appear beside both a red and a
green program status identifier.

Table 2: Program status identifiers

• Set Program as Startup program 
With the button Startup program you set any program as start program.
This is activated with every restart of the vision system and executed by
default.

° Using your mouse select the program in the table and then click on the
[Set As Startup] button.

The blue start program identifier appears beside the selected
program.

ADVICE
If you delete the program set as start program and do not set a new start
program, the next time the vision system is restarted an empty program is
created and used as start program.
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• Change PLC ID

With the function Change PLC ID you can manually assign a PLC ID for the
selected program. This is necessary to enable the program change via the
process communication or digital outputs (see "External program change
and trigger", Page 107).

• Upload Program

With the function Upload you can load a program saved on your PC on the
vision system. Click on [Upload] and select the source directory and the
program that you want to upload. In the following dialogue you can define
the name of the program on the device and determine a PLC ID.

• Download Program 

With the function Download you can save a program saved on the Flash
memory of the vision system on your PC. Select the desired program and
then click on the [Download] button. Then select the target directory and the
file name under which you want to save the program.

• Delete Program 

With the function Delete program you can delete any program saved on the
Flash memory of the vision system. Select the desired program and then
click on the [Delete] button. Confirm the prompt with [Yes].

Login as 

Image 7: Dialogue Login

Here you can log in to one of the five different user levels.

If no password has been set for a user level, you can log in without a password.
To set a password for a user level, go to Manage Logins and set the name and
password. If you have logged in successfully, the user name is displayed in the
status bar of the user interface.

Manage Logins

Image 8: Dialogue Manage Logins

The user interface offers different user levels with different access rights to the
program or the device settings. You can set a name and password for each
level. If no password has been set for a user level, the user can log in without a
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password. Only the administrator can change passwords and user names at all
user levels. Other user levels are not allowed to change password / names, not
even their own.

The following user levels are available:

• Read only (the user can only read and has no change rights)
• Operator (the user can read and change programs)
• Adjuster (the user can read, change program parameters and shutter,

capture images and do an test all)
• Administrator (full access rights)
• Rescue (full access rights, but the password is the manufacturer's and

cannot be changed)

ADVICE
Commands that require a higher user level than the currently active ones are
greyed out throughout the program and are not available.

To change a user level, enter a login name and password for the corresponding
level and confirm by entering the password of the current user. The passwords
and names are then immediately stored on the device.

As soon as an administrator password has been specified for a vision system,
the login data is requested for each connection process with the corresponding
vision system. The highest user level without password is automatically
selected. If a password has been set for each user level, you must specify the
desired user and password.

Digital IO settings

Image 9: Dialogue Digital IO settings

Here you can set the signal mode for the Ready-Signal via the selection list..
The Ready signal signals to a connected periphery device (e.g. PLC) that the
vision system is ready to receive data (e.g. a trigger signal). It also shows you
that the device is currently running calculations or is ready to trigger. Four signal
types can be selected for the Ready signal:

• Level mode The active levels are maintained as long as the vision system is
in the Ready status.
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H

L t
Image 10: Signal profile High-
Active Level

High-Active Level
The Ready-OUT is set from Low level to
High level

H

L t
Image 11: Signal profile Low-
Active Level

Low-Active Level
The Ready-OUT is set from High level to
Low level

• Pulse mode: The levels are applied according to pulse length.
The pulse length ti [ms] can be entered in the text field below it.

H

L t
ti

Image 12: Signal profile High-
Active Pulse

High-Active Pulse
A high pulse is created on the Ready-
OUT

H

L t
ti

Image 13: Signal profile Low-
Active Pulse

Low-Active Pulse
A low pulse is created on the Ready-OUT.

Reserving lighting outputs

Here you can reserve digital outputs of the vision system for lighting control.
If you select one or more outputs, the outputs are displayed in the Camera
register as a selection option under the Lighting Interface option. You can then
define which lighting is to be switched in the current program. This setting is
then made in the program, while the reservation of the lighting inputs is a device
setting.

In the Output register, the digital outputs reserved as lighting outputs are
crossed out and the line is greyed out. These outputs cannot then be used for
type output.
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Process
Communication

Here you can make the settings for communication via external interfaces.
Depending on the vision system, the following interfaces are available:

• Ethernet Server
The Ethernet server interface makes it possible to use an Ethernet server on
the vision system as a process interface. Enter the TCP port of the Ethernet
server as the parameter. With an Ethernet client, you can then connect to the
process interface by specifying the IP address of the vision system and the
TCP port assigned here on the client.

• Ethernet Client/Modbus TCP
The Ethernet client interface makes it possible to use an Ethernet client on
the vision system as process interface to communicate with a Modbus TCP
server. Enter the IP address and TCP port of the Modbus TCP server as
parameters.

Some of the interfaces have different or separate protocols (see below).
If you do not want to use a process interface, click Deactivate Process
Communication..

At the bottom right you will find a selection box for changing programs. If you
activate the box, a program change is allowed via process communication (see
"Trigger and program change via the process interface").

ADVICE
If you change the protocol or the interface or interface settings, the device
must be restarted for the settings to become active. The device settings are
automatically saved. Do not disconnect the device from the power supply
during storage!

Protocols

The following protocols are available for the two interfaces (information on
the format of the measured value data sent via these protocols can be found
here: "Format of the transmitted measured data", Page 109):
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3964R

° Byte order (Motorola / Intel)
° Coordinates system (Image / World)
° Acknowledgement timeout
° Character timeout
° Set-up attempts
° Transmission attempts

ASCII (Results are sent as readable characters)

This protocol can be used in conjunction with telnet or other terminal
programs.

° End of number (character appended to each number/result)
° End of block (string in HEX code sent after each complete block of

measured values)
° Coordinates system (Image / World)

Binary(Results are sent in binary format)

° Coordinates system (Image / World)

ModbusTCP (only Ethernet Client)

This protocol can be used to connect to a ModbusTCP server (e.g. PLC).
° Coordinates system (Image / World)

Change Device Name 

Image 14: Dialogue Change Device Name

Here you can individually define the name of the currently connected vision
system. The changed name is then displayed in the upper left corner of the
Connect/Disconnect toolbar, in the device information and in the network device
management.

Save Device Settings

Here you can save the changes made in the Device menu for the currently
connected device so that they are retained the next time the vision system is
started.

Reset to Factory
Settings

Use this option to reset the device to factory settings. All programs are deleted
and the device settings are reset.

ADVICE
The IP address settings of the vision system are retained even after resetting
to the factory settings, so that you can then re-establish a connection.
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5.2.1.1.4 Menu Image

Image 15: Menue Image

To open the Image menu, click the Image command on the menu bar.

ADVICE
You can also execute all commands with the respective buttons in the
"Test all" toolbars (Enable/Disable Image Capturing, Test All), "Capture
image" (Live video, Capture image) and "Load/ save image" (Load image
from PC, Save image to PC; hidden by default). You will find more on the
toolbars in section X.

Load image from PC

The function Load image from PC allows you to install a saved image on the
hard drive on the vision system and display it in the camera image window so
you can run sensor functions directly on this image. The "*bmp", "*png" and
"*jpg" file formats can be used. When an image is loaded in the vision system
the Activate/deactivate capture image button is automatically deactivated.

1. To load an image on the vision system, click in the menu bar on Image >
Load image from PC or in the toolbar on Load image.

2. In the dialogue box select the directory and the image you want and confirm
with a click on [Open].

Load image on PC

The function Save image on PC allows you to save the image currently
displayed in the camera image window in an image file on your computer.
The images can be saved in the three formats *.jpg, *.png and *.bmp with and
without overlay (test elements, laid over the actual image).

1. To save an image on the vision system, click in the menu bar on Image >
Save image on PC or in the toolbar on Save image.

2. Select a directory and a file format and give the image file a name.

3. Confirm with [OK].

Capture image

With the Capture image function with an existing connection between user
interface and a vision system you take a current image from the sensor's
chip, which is immediately displayed for you in the camera image window. An
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external trigger signal is not waited for here and the status of the Activate/
deactivate capture image button is not taken into consideration.

• To capture an image, click in the menu bar on Image > Capture image or in
the toolbar on Capture image.

Live Video 

With the function Live video with an existing connection between user interface
and a vision system you activate a continuous transfer of the currently recorded
sensor image to the camera image window. This allows you to readjust the
position of your test object and the operating distance, and to fine-tune the
exposure time if required.

When the function is active, most of the commands and functions of the user
interface are inactive and greyed-out. You can still disconnect the connection
to the vision system, adjust the exposure and lighting, and of course deactivate
the "Live video function" again.

• To activate or deactivate the Live image click in the menu bar on Image >
Live video or in the toolbar on Live video.

A blue outline around the button or the icon in the image menu shows
that the function is currently active.

Activate/deactivate
capture image 

The command Activate/deactivate capture image determines whether to
respond to an external trigger signal or to capture a new image at an test all

• Activate image capture if you want to start an overall test via an external
trigger signal. A new image is then taken. This new image overwrites the last
image displayed in the camera image area.

• Deactivate this command when you want to work with saved images from
the hard disk or want to apply changed parameters to the same image again.

ADVICE
The external trigger input is always active when the vision system is not
connected with user interface.

The command's current status (activated/deactivated) is shown by how the
button icon appears. It is deactivated when the camera in the icon has a red
crossed circle and the button says "Activate capture image". If the function
is activated the camera in the icon is shown green and the command is
"Deactivate capture image".

• To activate or deactivate "Capture image", click in the menu bar on Image
< Activate or Deactivate capture image or in the toolbar on Activate or
Deactivate capture image.
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5.2.1.1.5 Menu Tools

Image 16: Menu Tools

To open the Tools menu, click the Tools command on the menu bar.

UI options 

Image 17: Dialogue UI options

• Language
Under Languages you can set the language you want for the user interface
via a selection list. The language settings of your Windows operating system
are accepted when you select the Accept Windows settings option. With
all languages apart from German and English as Windows language, English
is used automatically. When you have selected the language you want and
confirmed with OK, this is accepted with the program restart. When you have
selected the language you want and confirmed with OK, this is accepted with
the program restart.

• Archiving directory
Unter Archivierungsverzeichnis können Sie ein Verzeichnis definieren, in
welches die Benutzeroberfläche die Prüfbilder und Messwerte abspeichern
soll. Dies erfolgt immer für das jeweils aktuelle Programm. Es wird jeweils
ein Unterverzeichnis mit dem Namen des Programms angelegt, in welchem
dann die Bilder für die im Reiter Ausgabe (see "Introduction", Page 104)
angegeben Typen gespeichert werden.

1 Click on the button [...]
2 Select the desired directory in the following dialogue
3 Then confirm with [OK].

• Advices
Use the Reactivate all advices button to reactivate note dialogue boxes that
you have previously hidden by clicking on the "Do not display this dialogue
again" option.
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Manage Network
Devices

Image 18: Dialogue Manage Network Devices

The Manage Network Devices dialogue provides you with an overview of
the vision systems that are located in your network or that you control via the
user interface. Devices on the same subnet as the host machine are found and
displayed automatically, while devices outside the subnet (behind a router) can
be added manually.

• Add device entry
Here you can manually add a device to the list of network devices Enter a
device name and optionally an IP address under which the device is to be
found.

• Change / delete entry
If you select a device from the list, you can change the respective entry
(device name, IP address) or remove it from the list. The device itself is not
changed.

ADVICE
This option can only be selected for devices that were previously added
manually.

• Change device IP address
Here you can change the IP address on the device itself. This option is only
available if no password has been set on the corresponding vision system.

5.2.1.1.6 Menu Help

Image 19: Menu Help

To open the Help menu, click the Help command on the menu bar.

Help The Help command allows you to display the user interface manual in HTML
Help  format. Here you can search for keywords using the search text field,
jump to the desired item in the navigation tree or print out individual chapters.
Alternatively, you can also access HTML help by pressing function key F1.
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About

Image 20: Dialogue About

The About command displays the version number of the user interface and
contact information about the manufacturer.

5.2.1.2 Toolbar

Toolbars consist of buttons with small icons that give you quick access
to individual commands. They contain a preselection of frequently used
commands.

The standard settings of the user interface of the toolbars include the toolbars
Connect, Capture Image, Test All. In the default view, the predefined Load/
Save Image toolbar is not displayed.

Connect / Disconnect

Use the Connect toolbar to connect to a device or a simulator via the user
interface. To do this, select the appropriate device from the drop-down list and
click [Connect].

If a connection already exists, the name of the device is greyed out and the
drop-down list is not available. Click [Disconnect] to disconnect from a device/
simulator.

Live Video / Capture
Image

Use the Capture image toolbar to switch to live video mode or capture an
image. These buttons are functions from the Image menu. Further explanations
can be found at see "Menu Image", Page 26.

Test All

Use the Test All toolbar to perform an overall test of your image processing
functions. Use the [Enable Image Capturing] or [Disable Image Capturing]
button to enable or disable the active or triggered image capturing. These
buttons are functions from the Image menu. Further explanations can be found
at see "Menu Image", Page 26.

Load Image / Save
Image

This toolbar is not included in the default view. You can show them in an own
view, which you can compile according to your wishes. For more information,
read the chapter see "Add view", Page 18.
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Using the Load / Save Image toolbar, you can load an image from your PC to
the device or simulator or save a captured image on your PC. These buttons
are functions from the Image menu. Further explanations can be found at see
"Menu Image", Page 26.

5.2.1.3 Parameter Area

In this area you will find the functions of your vision system. The arrangement
of the individual registers corresponds to the configuration and processing
sequence of the test program.

Tab Description

Camera Here you configure the exposure time (shutter of the
image sensor) and the state of the illumination (on, off,
triggered).
Further explanations can be found at "Configure
camera", Page 14.

Tracking Here you can set a position tracking when varying
the position or rotational position of objects to be
inspected. This moves all checks to the position of the
test object.
Further explanations can be found at "Tracking",
Page 51.

Functions Various functions for testing, measuring, controlling
and identifying objects are available here.
Further explanations can be found at "Functions",
Page 42.

Output Here you can typify test results and assign the output
assignments for the results of the tests.
Further explanations can be found at "Output",
Page 104.
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5.2.1.4 Camera Image

The camera image window shows the current image to be checked. It is used
for parametering the functions via different image processing areas, which are
shown as overlays. You can also have the test results displayed and collect
important information for the parametering with your cursor.

Camera Image

Show Result Image Format (Bild)

Grey Value Display

Image 21: Window Camera Image

Show Results In the upper left you will find the command Show results for with a
corresponding drop-down list.

Here you can display the results of executed test functions. You can choose
whether the results of all functions or only the currently selected function are to
be displayed in the camera image.

Image 22: No Function Image 23: Selected Func-
tion

Image 24: All Functions

The function name appears together with the result values either in green font
(positive result) or in red font (negative result) as an insertion above the camera
image. Furthermore, points, areas or patterns found or checked by the function
are marked. Blue guide lines are displayed in the measurement functions to
illustrate the lines found (see "Image processing areas", Page 43).

Transfer format of the
images

At the top in the middle you will find the drop down list for selecting the transfer
format for the images. You can choose between the formats BMP and JPG in
3 quality levels. When an option is selected, the image with the corresponding
quality is retransmitted from the machine vision system.

The set transmission format affects the settings for image storage in the Output
tab, i.e. the transmission quality set in the camera image is decisive for the
quality of the stored image(see "Save settings", Page 105).
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This option has no effect on the saving of pictures via the menu Image > Save
Image to PC (see "Load image on PC", Page 26).

ADVICE
Use of lossy image compression (JPG)

If the JPG option is active, the image is already compressed and displayed by
the vision system as lossy JPG. This enables a faster image transmission at
the cost of a lower image quality.

Use this option only for very limited bandwidth, because compression
changes the grey values of the image.

Display grey value

In the upper right corner of the bar you can see the current position of the
mouse pointer within the camera image area (in coordinates) and the grey value
of the corresponding pixel that the mouse pointer points to in real time. Use
this function, for example, to parametrize grey value limits. When using lossy
compression (JPG), the grey value displayed may differ from the actual grey
value.

5.2.1.5 Result Area

In the Results area, the results of the function are output after a completed
single or overall test (Test All). In this window, only the result of one test is
displayed, others can be called up via the navigation bar. The structure is
designed as follows after the overall test has been carried out:
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Navigation Using the navigation bar you can scroll through the Single test results of a log.
The log is automatically created with a test process and can be saved and
imported again later. The navigation bar consists of navigation buttons and the
results navigation, from which you can read how many results are available
and what result you are at in the test series order. You can also jump here via
manual page entry to any test result. You will find the functions of the navigation
buttons in the table.

Symbol Function

Scroll to the next or last test result in the log.

Scroll to the next or last test result in the log, whose target
type has not yet been reached (exclamation mark) or whose
target type is not up-to-date (question mark).

Scroll to the next or previous bad test result in the log (only
with Test all).

Scroll to the last or first test result in the log.

Log The log can contain a maximum of 100,000 results. Furthermore, the test
images of the last 5,000 tests are stored and are thus available over the course
of the test.

The overall result contains the required execution time in milliseconds, the type
determined and the status symbol for a good, successful ( ) or bad, failed ( )
test.

Below this, the function results are listed individually in the result history, which
also contain the determined measured values in addition to the execution time
and symbol. Depending on the function, these are, for example, a position, an
area, an angle of rotation or a degree of conformity.

Target Type The target type details only appear with the performance of Test all and
if it consists of a selection list that lists all types defined in the Output tab
(see "Output", Page 104). You can manually assign a specified type to the
current test result with this, e.g. to test your parameter settings. Otherwise this
automatically corresponds with the type determined by Test all.

If an assigned target type does not correspond with the determined type (with
Test all, Batch test), a red exclamation mark appears beside both the target type
details and the function result, which caused the deviating type with its Single
test result ( ). You can then recognise which function you have to parameter so
that the test result corresponds with the target type you want.

If a new type is created in the I/O Manager with existing test results, a grey
question mark appears beside the target type details and beside the function
results ( ). This shows that the test or the evaluation has still not yet been
performed with inclusion of the new type available.
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5.2.1.6 Status Bar

This area displays system and program information.
Program status Device settings User Test status

• Program status
Here you can see whether the currently active program has been saved.
As soon as a change is made, the display changes from a green dot to a
red dot and shows the message Program not saved (see "Save Program",
Page 16).

• Device settings
Here you can see whether configurations on the currently connected device
have been changed.
As soon as a change is made, the display changes from a green dot to a red
dot and shows the message Device settings not saved (see "Save Device
Settings", Page 25).

• User
Displays the user rights with which you are logged in (see "Manage Logins",
Page 21).

• Test status
As soon as a test is performed, this display changes to a blue dot.

5.2.2 Adapting the user interface

The display of the user interface can be changed and adapted. Use the docker
windows and the toolbars.

You can only make adjustments in the views you have defined yourself.
Predefined views cannot be changed or modified. However, they can be used
as a source view for new views.

Pre-defined views:

• Default
• Calibration
• Batch Test
• Monitoring

To select pre-set views or add new views, read here: see "Select view",
Page 17.

A detailed explanation of the possibilities for change can be found in the
following sections, subdivided into the areas Window area and Register area
and Bar area.
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Create a new view

1. Open the dialogue via Menu > View > Add View

2. Select the basic view to be used as the source view.

3. Assign a name to the new view.

4. Confirm with[OK].

5.2.2.1 Window area and Register area

Elements of the user
interface

The user interface is divided into the two area types Window area and Register
area, in addition to the bar area.

In the "Default" view, a window area consisting of the Camera Image and
Results windows and the tab area are displayed.

There are a total of four window areas available. They are located to the left, to
the right, above and below the register area, but in the default view, only the left
one is displayed and active. If you use all areas, the tab area will be completely
surrounded by window areas.

Each window area can contain any number of windows, but it must contain at
least one to be active and not hidden.

Basically, the two area types hardly differ in how the institution functions, but
there are a few important differences:

• The register area is a fixed area that is only designed for creating new tab
pages or registers. The window areas, on the other hand, consist of any
number of windows and are variable. Windows can be arranged in any
desired position and, in addition, tabs with several dialogue boxes can be
created in the individual windows.

• The register area is a fixed part of the user interface and cannot be hidden,
but the window areas can.
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• The windows of the window area are collapsible or expandable, the tab area
or individual tabs and tabs that are located in the tab area are not.

• A window area consists of at least one window, but the tab area can consist
of three tabs or not a single tab (in this case the area would be empty).

• The tabs of the registers in windows are visually different from those in the

register area: 

Adjustments You can make the following adjustments:

• Creating and moving windows and tabs
• Folding windows in and out
• Opening docking windows in external windows
• Changing the size of windows or areas
• Adding and removing docking windows

Basics ADVICE
A dialogue box can be displayed in both a window and a tab. This means,
for example, that you can easily convert an existing tab that contains the
"Functions" dialogue box into a window with the same dialogue box and
vice versa. To simplify, the window and tab are summarized below under the
generic term "Object".

"Handle" an object

To move an object or assign it to a tab, you must "handle" the object. Handle
means that you can move it through the image while holding the mouse button
and place it anywhere.

• To handle an object, click with the mouse on the title bar of the window or the
tab of the panel and keep the mouse button pressed.

A blue, transparent rectangle appears on your mouse, which, as long
as you keep the mouse pressed, follows your mouse movement.
This rectangle symbolizes the object to be moved (see "Image 0: ",
Page 37).

• To release a handled without moving or changing the object, click the right
mouse button and release the left mouse button shortly afterwards.

Control elements

Image 25: Control elements local / global
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The controls become active when you touch an object. They allow the creation
and positioning of objects within window areas and the tab area and are divided
into local and global controls (see "Image 25: Control elements local / global").
The local controls each consist of four position elements and a tab element in
the centre and are used for windows and tabs, while the global controls consist
of only one position element and allow window areas to be activated. They are
always in the register area. Where or which controls become active depends
on where you are with the mouse and the handled object. For example, if you
are still in the same window with the "handled" camera image window, only the
global controls above the tab area are active. If you now move the mouse over
a register of the register area, the local controls of the register also become
active. If you then move the mouse over the Result Output window, the local
controls of the window become active, but those of the register disappear again.

Local controls become active only there, above which you are with your mouse
and where is not the starting position of the currently handled object. The
global controls, on the other hand, are only active at the position (right, left, top
or bottom of the tab area) where a window area is not used and is therefore
inactive. Active controls allow you to insert, move or create objects by simply
"dropping" the dragged object onto a single element (release the left mouse
button). Please read the step-by-step instructions later in this section.

Dialogue window

In addition to customizing the layout of each dialogue box, you can choose
which dialogue boxes to display in your view. Go to the command View >
Window in the menu bar and check the dialogue box which should be included
in the view. All other dialogue boxes are not displayed. If you accidentally close
a dialogue box, you can use this method to reintegrate it into your interface.

Step-by-step
instructions

These instructions are based on the default view "Default" as source view.

To insert an object as a window

1. Select the object to be moved via "Handle".

2. Select where you want to move the object.

° To move the object to an active window area, move the mouse over the
window to which you want to move the object. Then move the mouse to
the desired local position element, which determines the position.

The position element is bordered in blue and the blue-transparent
rectangle shifts within the window in the desired positioning direction.

° To move the object into an inactive window area, move the mouse to the
desired global position element.

The position element is bordered in blue and the blue-transparent
rectangle moves within the register area in the desired positioning
direction.

3. Release the mouse button.

The object is inserted at the desired position.

To move a tab

1. Select the tab to be moved via "Handle".

2. Move the mouse to the tab of the tab where you want to move the selected
tab.
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The tab and the tab are filled with the blue-transparent rectangle.

3. Release the mouse button.

The tab is inserted at the desired position and moves the existing tab.

To insert an object into a tab or create a new tab

1. Select the object to be moved via "Handle".

2. Select where you want to move the object.

a) To insert the object as a tab, move the mouse over the tab in which the
object is to be inserted and then over the tab element.

The register element is bordered in blue and the register is filled with
the blue-transparent rectangle.

b) To insert the object into a new tab in the tab area, move the mouse over
the tab to which the new tab is to border and then over the desired local
position element.

The position element is bordered in blue and the blue-transparent
rectangle shifts within the window in the desired positioning direction.

c) To insert the object into a new tab in the window area, move the mouse
over the window that is to form a new tab together with the selected
object and then over the tab element.

The register element is bordered in blue and the window is filled with
the blue-transparent rectangle.

3. Release the mouse button.

The object is inserted as a tab page in a tab.

To hide a window and make it visible again

1. Click with the mouse in the title bar of the window on the icon Auto hide.

The window is collapsed to the edge of the respective window area. A
button of the same name is displayed at the edge.

2. Move the mouse over the button of the hidden window to expand or make
the window visible again. As soon as you move the mouse away from the
button, the window is collapsed again.

3. Click with the mouse in the title bar of the window again on the button Auto
hide to cancel the function again.

The window is restored to its original position.

To scale windows and areas

1. Move your mouse over the boundary between two windows so a double-
headed arrow appears.

2. Hold the mouse button as if you were handling it and move the mouse in the
corresponding direction to enlarge or reduce the window.



metimus 1.7.0.6
Part 2 - First Steps and User Interface

40 999.994.424.10-en-1.0 © Vision & Control GmbH 2018

To create external windows

To open dialogue boxes in external windows, double-click the window title
bar.

You can also drag and drop external windows to anchor them back to the user
interface. Furthermore, external windows can be maximized by double-clicking
on the left.

5.2.2.2 Bar area

The menu bar and the toolbars differ considerably from the customization
options compared to windows and tabs. They are in their own bar area and
cannot be moved to the window area or tab area. However, the bar area can be
extended downwards as required.

Features and
customization options

Menu bar

• The menu bar contains important commands for working with the user
interface and cannot be removed from the user interface.

• The display of the individual commands such as File or View cannot be
changed or the sequence of the commands cannot be reversed.

• The menu bar can be moved and arranged within the bar area for the views
you have defined yourself.

Toolbar

• The toolbars can be moved and arranged independently of each other in
the views you have defined. The elements are firmly anchored in the pre-set
views. The individual toolbars are called:

Capture Image

Test All

Connect

Load/Save Image

• There are three options for displaying the buttons: Icon and Text, only Icon
and only Text. This is set individually for each toolbar.

Step-by-step
instructions

These instructions are based on the default view "Default" as source view.

To move a bar

1.
Move your mouse over the grey dots on the left side of the bar. 

The mouse pointer becomes a quadruple arrow.

2. Click with the left mouse button on the grey dots and move the bar with the
mouse button pressed to the desired position in the bar area.
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To change the appearance of a toolbar

1. Right-click a toolbar button.

The context menu opens (see "Image 26: Context menu of the toolbars").

2. Move the mouse over Command Show and then click on the desired form of
representation (Icon and Text, Icon or Text).

The change will take effect on all buttons on the toolbar.

To show or hide a toolbar

1. Right-click in the list area.

The context menu opens (see "Image 26: Context menu of the toolbars").

2. In the context menu, click the name of the toolbar you want to show or hide.
Already displayed toolbars have a check mark to the left of the name.

Image 26: Context menu of the toolbars
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6 PART 3 – INTRODUCTION TO FUNCTIONS AND FUNCTION
REFERENCE

6.1 Functions

Introduction In the user interface you have different functions for testing, measuring,
controlling and identifying objects. You can open these functions in the tab area
via the Functions index card. You will find a list of functions here, in which all
created functions of a program are listed.

The gray value test, brightness percentage and area test functions have an
Auto function. This enables automatic parametering based on the current
image. Although the parameters determined here do not have to be the
optimum values, they are good starting values, which can be further refined.

You can run the test functions via an single test (see "Single test", Page 43)
or an Test all. While the single test only tests the currently selected function,
with an Test all with "Capture image", all functions included in the program are
performed and evaluated, including tracking.

Function overview Surface verification

• Pattern search

Surface checks

• Area test
• Gray value test
• Brightness percentage

Completeness checks

• Area test

Measuring

• Caliper
• Edge position
• Measure angle
• Edge rotation
• Measure circle
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Add function 1. To add a function to the current program, click under the function list on Add.

2. In the subsequent dialogue box select the function you want and enter an
informative function namein the text field. 

3. Confirm with OK.

The function appears under the entered name in the list of functions.

Change function • To change an existing function or to activate its parameter area, select the
function in the list of functions with your mouse.

Delete function • To remove a function from the current program select the function with your
mouse in the list of functions and then click on Remove.

The function is deleted from the list of functions and the program.

Single test

With the Single test button you start a test process for a currently active
function. All other functions are not tested. A new picture is not taken with this
test, which makes it especially suitable for checking adjusted parameters.

The Single test button only becomes active when a function has been selected.

6.1.1 Image processing areas

Die Bildverarbeitungsbereiche sind farbige, transparente Flächen in denen
beispielsweise Antast-, Prüf- oder Suchabläufe stattfinden. Diese Bereiche
sind funktionsspezifisch und unterscheiden sich je nach Anwendungsgebiet.
Die geometrische Form der Bereiche lässt sich bei manchen Bereichstypen
beliebig einstellen und verändern, um eine optimale Anpassung an die Form
des Prüfobjekts zu gewährleisten. In den folgenden beiden Abschnitten werden
sowohl die verschiedenen Typen kurz erläutert (see "Area types", Page 44)
als auch die Möglichkeiten der Anpassung dieser Bildverarbeitungsbereiche
(see "Geometrical shapes and adjustment options", Page 46) vorgestellt.
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6.1.1.1 Area types

Teach area

The Teach area is active with the Pattern search tracking and the Pattern
search function and is shown with a green-transparent area with green
border. The content that this green area includes is taught-in so that it can be
determined again inside the search area. The Teach area should therefore
include a prominent test object structure to enable the best possible recovery
within the search area. Note that the size of the border affects the processing
speed of the vision system and the border should be adjusted as optimally as
possible to the structure to be taught-in to avoid any unnecessary processing.
Note here that some border around the test object is always required.

Search area

The Searcharea is only active with the Pattern search tracking and the
Pattern search function and is shown with a red-transparent area with red
border. Inside this area the search algorithm then works to find concurrences
with the taught-in area. The test object must therefore be in this area so that
it can be accurately detected. Note that the size of the border affects the
processing speed of the vision system and the border should be adjusted as
optimally as possible to the area to be searched to avoid any unnecessary
processing.

ADVICE
The Teach and the Search areas are active simultaneously in the camera
image. When you choose one of the areas the other one goes into the
background and becomes more transparent, but can still be clicked on and
processed.

Inspection Area

The Inspection area has the same appearance as the Search area. The
content of the pulled up area is checked for important information, such as gray
values and surface area, for example. The inspection area should optimally
include the area to be checked in order to avoid unnecessary processing and to
obtain an informative test result.
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Recognition area

The user cannot adjust the Recognition area, unlike the other image processing
areas. It shows determined function results within a tested area in blue. With
the Area test or Brightness percentage functions and the Edge and Object
search functions all the pixels that meet requirements are coloured blue and
marked within the inspection area. The trackings and the Pattern search
function identify found patterns with a blue arrow. With the Locate circle
tracking and the Measure circle function only a blue cross is shown.

Detection area

The Detection area is the image processing area for Edge and Object
searches and is shown with a transparent, red square and a transparent red
circular ring segment. Edges and contours within the image can be found
via the Detection area (detected) and these can be used for testing object
properties. The direction of the detection of such an edge is shown with the
detection arrow inside the area, and can return to the same with a click.

Note that the size of the Detection area affects the processing speed of the
vision system and the border should be adjusted as optimally as possible to
the area to be detected. With a smaller area fewer pixel lines have to be run
through, which sharply accelerates the processing.

The detection area can be scaled, turned and moved in any way (see
"Geometrical shapes and adjustment options", Page 46). Shape and
elements differ according to the respective functions:

• Tracking via Locate corner: Two rectangular detection areas are active, and
are connected with a red dotted line.

• Caliper: Two rectangular detection areas are active, aligned on two red
dotted, parallel lines and can only be moved within these lines. The complete
element can be moved and turned via the free area between the detection
areas or via the rectangular detection window.

• Edge position: A rectangular detection area is aligned with a reference
line via two red dotted, parallel lines, which can be positioned wherever you
want. The detection area can only be moved within these parallel lines; you
can turn and move the complete element across the free area between the
reference line and the detection area. The element can also be rotated in the
detection window itself.

• Measure angle: Two rectangular detection areas are active, and are
connected with a red dotted line angle arc and two angle legs. The angle arc
shows the measured angle type (inside angle and outside angle).
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• Edge rotation: A rectangular detection area is connected via a red dotted
angle arc and an angle leg with a reference line (the second angle leg),
which can be positioned wherever you want. The angle arc shows the
currently measured angle types (inside angle and outside angle).

• Measure circle: It is the detection area as a circular ring and circular
ring segment, with which you can scale the inside and outside radius and
therefore the ring thickness. A circular contour is detected with this function.
This area can be processed like the ellipse ring segment geometrical shape
(see "Ellipse ring segment", Page 47).

6.1.1.2 Geometrical shapes and adjustment options

The geometrical shapes of the image processing areas can be selected under
the parameters of the respective function. The preset shape is a rectangle,
but ellipse, ellipse ring segment and free-form shapes can also be selected.
For every shape you can have exact data, such as edge lengths, centre point,
radii, etc. shown, when you move your cursor over the corresponding shape.
The geometrical shapes can only be selected with the image processing areas,
"Teach area", "Search area" and "Inspection area".

ADVICE
If you position an image processing area completely outside the image, so
that you can no longer click it with your mouse, a miniature view of the image
processing area appears in the top left corner of the picture window with a
white arrowhead, which points to where it is (hidden). Click on the miniature
view to show the image processing area again in the image.

Default shapes
(rectangle and ellipse)

You can adjust all image processing areas (size, position and rotation point),
apart from the recognition area. This allows you to optimally adjust the areas
to the image section to be checked. The adjustment options for the rectangle
and ellipse shapes are explained briefly below. They can also be applied to the
ellipse ring segment and free-form shapes.
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Action Cursor How

Move Place the cursor over the image processing area,
left-click your mouse and with pressed button
move the area to the position you want.

Change size Place the cursor on the edge of the image
processing area, left-click and keep pressed. With
a cursor movement to the area it reduces; move
the cursor away from the area and you increase
the area. While the vertical and horizontal double
arrow allows you to change size on one level,
on corners and diagonals with a diagonal double
arrow you can adjust on both levels at the same
time.

Rotate Place the cursor over the image processing area,
right-click and keep pressed. You can now rotate
the area any way with a circular mouse move-
ment.
To rotate the area in full degree values, keep your
right mouse button and the Ctrl button pressed at
the same time. This makes precise alignment of
the image processing areas easier.

Ellipse ring segment 

The ellipse ring segment is a segment of an ellipse-shaped ring. You can
change both the diameter of the ring inside and the ring outside by pulling with
the double arrow and therefore individually adjust the ring thickness. You can
extend the segment through to a complete ring as follows:

Action Cursor How

Increase/
reduce
segment

 
Place the cursor on the segment edge, left-click
and keep pressed. Now move your cursor with
a circular movement to close the ring or open it
further.

Free-form 

The free-form is an individually shaped polygon, with which you can recreate
every possible geometrical shape. The special feature here is that you yourself
can create another polygon within an existing area. With this kind of overlapping
of two polygons the respective areas are negated, i.e. you can create a hole or
an internal free-form that does not belong to the overall shape. You can also
add any amount of new points and decide whether the connection line between
two points is to be straight line or a circular line.
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Action Cursor How

Move a point
 

Place the cursor over a point, left-click your mouse
and with pressed mouse move the point to the
position you want.

Add a point To add a point place the cursor over a connection
line and double left-click.

Create a
circular/
straight line

To make a circular line from a straight line place
the cursor over a straight line, left-click and keep
pressed. Now pull a circular line with your mouse.
To make a straight line from a circular line place
the cursor over a circular line and double right-
click.

Create a
polygon

To create a new polygon place the cursor over a
filled area of the free-form and double left-click.

Delete a point/
polygon  

To remove a point place the cursor over a point
and double right-click.
There must be at least one other polygon to delete
a polygon from the free-form. Remove as many
points until the polygon is only a triangle. If you
remove another point you will delete the entire
polygon.

6.1.2 Batch test

Introduction

You will find the automatic test dialogue field by default in the preset Batch test
view in the tab area. If you have not yet tested any functions and therefore there
are no function results in the log, all parameters and commands are greyed-out
in this dialogue box. They only become active when there are results in the log.

The batch test performs overall tests for a definable number of existing test
images and prepares the results visually in statistics. The respective currently
set test parameters are used here. Please note that the results of the automatic
test series overwrite the existing test results.

The target types, however, are not automatically adjusted to the result, but with
deviation from the specifications are given an exclamation mark (see "Target
Type", Page 34). This makes it easier for you to parameter functions, when
you check several sample images in line with your specified target types (test
part with error 1, test part with errors 1 + 2, etc.). You can then manually assign
the corresponding target type to every image (see "Output", Page 104). If
you then parameter the functions, via the batch test series you can check
every setting to see if all images with a test process comply with the specified
target type or if you must make further adjustments, so that all results and
types correspond with your specifications and therefore the function has been
optimally parametered for your purposes.
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With defined test images you can also check if a changed program (e.g. after
adding a new test part or feature, program parameters change, etc.) finds and
assigns recently taught features and still properly classifies the already existing
test results. If not you must parameter the function again. Possible "pseudo-
rejects", for example, are consequently reduced.

Parameters Test from result … to result

Here you can specify the range of your log, which you want to test with the
batch test. To do this enter the test result number at which the test is to start in
the first value field. Then enter the test result number at which the test is to end
in the second value field. You can also adjust the numbers in the value fields via
the arrow buttons on the right.

Interrupt test, as soon as ...

You can specify the abort criteria for a test run here. You can select from three
different criteria. You can also set more criteria, which are OR-linked. This
means that only one of the selected criteria must apply so that the test run is
aborted. The criteria are:

a) A test failed ("Other" type)
The test run is aborted as soon as one of the tests is assigned to the "Other"
type, i.e. does not correspond with any of the specified types.

b) Type ... was reached
The test run is aborted as soon as a test result corresponds with the settable
type. The preset target type does not apply here! Select the type in the drop-
down menu.

c) A target type failed
The test run is aborted as soon as the type of a test result does not
correspond with the set target type

Statistics

The last test run executed is evaluated in the "Statistics". You can read:

• Duration of the slowest (min.), average and fastest (max.) test
• Test images assignment to the available types

The test images are not only assigned to the respective types and counted
here. If the target type with individual test images does not concur with the
determined type (the target type is not achieved), this is added in the lowest line
and illustrated graphically, as in "Other" type cases, with a red bar.
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6.1.3 Monitoring

Introduction

You will find the Monitoring index card by default in the preset Monitoring view
in the tab area. To go to the view click in the menu bar on View - Monitoring. In
the top part the index card contains the general device information, name, serial
number, software version, camera resolution, camera type and calibration.
Below this you see a table with all programs saved on the device and the
respective PLC IDs.

Information on
program status

At least one program circle identifier is shown in the table in front of a respective
program. The respective meanings of the different colours are provided in the
legend in the bottom part of the window and are also subsequently explained.
The name of the currently active program is shown in bold.

Colour Meaning Explanation

Saved. The marked program is saved
in the current status.

Not yet saved. The marked program has not
yet been saved in the current
status.

Set as start program. The marked program is
currently set as start program.
This program status identifier
can appear beside both a red
and a green program status
identifier.

Table 3: Program status identifiers
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Activate program Via the Activate button you can activate one of the programs saved on the
vision system. First select the programe you want and then click on Activate.

6.2 Function Reference

6.2.1 Tracking

Introduction If the position or rotation position of objects to be tested can vary with the feed,
the precise object position must first be determined in the captured image.
With the position tracking functions you can teach in a test object with its image
features and position information and therefore lay the basis for applying the
test functions. A set-up tracking can detect the object's alignment in different
positions and ensure that image processing functions are performed.

The new alignment of the objects is detected by the Pattern search, Locate
corner or Locate circle functions, on which the respective tracking is based.
Pattern search here covers a rotation position area of 360°, while Locate
corner is only suitable for rotation deviations up to maximum 45°. Tracking with
Locate circle is only used for the x/y tracking and does not include any rotation
adjustment. If you apply a function with activated tracking to a test object, the
coordinates of the image processing areas are assigned in accordance with
the current position of the test object to a movable coordinates system. This
means that the new alignment and the determined function results are issued
relative to the taught position of the object. This simplifies application of the
image processing areas and evaluation of the test results. The position of the
image processing areas in accordance with the found alignment is also adjusted
to make parametering new functions easier.

As subsequent test functions depend on the tracking you should only
first parameter these after setting up the tracking, as otherwise the image
processing areas shift, which significantly impairs the test result. Once you have
set up the tracking it is always the first to be run with an overall test.

You will find the position tracking functions in the tab area by default under the
Tracking index card.

Single test button With the Single test button you start a test process for the selected tracking. All
other functions are not tested. A new picture is not taken with this test, which
makes it especially suitable for testing set parameters. The Single test button
only becomes active when a tracking has been selected.

Coordinates systems

The image processing system and the user interface essentially "know" two
types of coordinate systems:

• the image coordinates system
• the world coordinates system

The image coordinates system starts in the top left corner and positions are
given in pixels (e.g. 100, 100 px).
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The world coordinates system by contrast starts in the image centre and
positions are given in millimetres. The positive values of the x-axis are on the
right; those of the y-axis are below the image centre (e.g. -18.44 mm, 18.90
mm).

6.2.1.1 Tracking via Pattern search

Introduction The Pattern search function, which can also be selected as a test method, is
a possible method for tracking test objects and is based on the "Correlation"
search method, which compares image features. These features must be first
extracted from the available test object image to be digitally taught-in and stored
as a pattern. After the features have been taught in the "Correlation" search
method can search through any image on the digitally stored pattern, and with a
find determine where the test object now is compared with the taught pattern. 
An example: If the test object with the taught pattern was at point 300, 200 px
with 40° rotation position and the pattern is in the new image at position 350,
200 px with 45° rotation position, the relative position of the test object with 50.0
px and rotation angle with 5° are issued as the result.

How high the recognition factor of the pattern is and how high the concurrence
level was between taught-in and compared patterns are issued with every
tracking in percentage and therefore provide you with information on the
pattern's quality. If the concurrence level is too low the tracking is rated as failed
and subsequent test functions are not performed. This can, for example, be
caused by adverse brightness conditions or even a search area that is too
small. Several parameters are provided to increase the concurrence level and
therefore provide reliable tracking of text objects.

Parameters Teach area type

Via a drop-down menu you specify the geometrical shape you want for the
teach area here. You will find more information on the image processing areas
in section "Image processing areas", Page 43.

Displayed pattern

Here you select whether the taught pattern is to be displayed in the lowest
(Presearch), highest (Fine search) or original resolution. The Presearch here
represents the pattern with the coarsest search accuracy. This serves to
determine if the pattern to be searched is detectable. The "Fine search" then
shows the pattern as it is also found with search method concurrence. Both
displays change accordingly with an adjustment of the Search scale accuracy
parameter. The display tabs do not have any effect on the image processing
function itself - they are actually only a visual aid.
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Search scale accuracy

Here you specify the accuracy of the search method using a sliding controller.
The finer the accuracy is set, the better fine-structured objects or patterns will
be found. A coarser search by comparison requires less processing time. Find
the optimum setting by trying out different levels of fineness and observe the
corresponding resolutions in the pattern display as you do so. The search
scale accuracy setting should also be verified with different rotation positions of
the pattern.

The search algorithm begins its calculations on a very coarse image and tracks
the pattern found up to here up to a certain point in a somewhat finer image.
With a very fine setting the position found is then very accurate; with a coarser
one the corresponding position can, however, only be determined in specific
increments. The processing time, however, is significantly reduced because of
the lower data volume.

Pixel precise position correction

If you activate this checkbox, with a successful pattern search a pixel-accurate
search of the respective x/y position is performed. You receive a precise
position value for the object found. This setting, however, means a longer test
method processing time.

Search angle steps

Here you set the value of the increment with which the algorithm searches the
taught pattern in the given search angle range. The value can be specified
either via the sliding controller or direct value entry. The lowest possible setting
is 1°; the highest is 90°. The set angle shows that the pattern is rotated in the
corresponding ° steps and searched for in the selected search area of the
image. A higher search angle increment enables faster processing, while a
lower one increases the search accuracy.

Search angle range

You provide the angle range here in which the pattern is to be found. This
means, for example, that an object is only detected in a specific rotation position
or it can only be fed into the test in a specific test process-conditional rotation
position. As all possible positions and angles of rotation of the pattern are
searched for in the image with the pattern search, the amount of possible
combinations plays a decisive role for the processing time. With twice as big
a search angle range, you therefore generally get twice the processing time.
Furthermore with circular-symmetrical objects the pattern must also be found in
a complete 360° search, which the following example explains.
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Image 27: Adjust angle
range

The red angle range is symmetrical to the blue angle
range. As the object consists of a total of 16 such
areas (not all visible in the fig.), a search must now
only be made in the angle range 360°/16 = 22.5°. The
processing time decreases significantly.

To set the search angle you can raise the angle range with the red and green
balls. To do this click on the respective ball and move in the direction you want
with pressed mouse button. The blue marking shows the angle range covered.
A direct value entry with the parameters "from / to" is also possible in the two
fields on the right. The settable values are between -180.00 and 179.99°.

Minimum match

You can enter the level of similarity that must be achieved with the pattern
comparison here, so that the pattern is marked as found and the tracking was
successful. The entry is in percentage and should not be selected too low.
Values of more than 75% are proven settings in everyday industrial work. If the
minimum match is not achieved with the test, the function is rated as failed.

Search area type

Via a drop-down menu you can specify the geometrical shape you want for the
Search area here. You will find more information on the image processing areas
in section "Image processing areas", Page 43.

Object may exceed search area

If you activate this checkbox the object may exceed out of the search area with
up to 25% of its area and is still found. This is especially beneficial with the
possibility that test objects under certain circumstances are not always within
the search area because of position instability or inaccurate provision. This
setting, however, means a higher test method processing time.



metimus 1.7.0.6
Part 3 – Introduction to Functions and Function Reference

© Vision & Control GmbH
2018

999.994.424.10-en-1.0 55

Steps for setting up
tracking via patterns

1. Click on the Tracking index card in the
tab area and then on the drop-down
menu in the Function area. Select Pattern
search.

The parameter area appears in the
tabs.

2. Select the geometrical shape for the teach
area via the Teach area type drop-down
menu and surround the pattern to be
taught in as best possible in the camera
image with the border of the teach-in area.
Then click on the Teach button.

The marked pattern is taught in and
shown in the pattern display.

3. Adjust the following parameters to your
requirements:

• Search scale accuracy
• Pixel precise position correction
• Search angle steps
• Search angle range
• Minimum match

4. Select the geometrical shape for the
search area via the Search area type
drop-down menu. The search area's
border should surround the area in which
the object can lie in the image.

5. Adjust the Object may exceed search area parameter to your require-
ments.

6. Click on the Single test button to test the tracking settings.

a) If successful a blue arrow marks the object found.
b) If unsuccessful (concurrence achieved is too low), you increase the

search scale accuracy by adjusting the corresponding parameters (see
step 4) or by teaching in a more distinctive pattern (see step 2). Then
click on Single test again to check your changes.

7. Change the position and rotation position of the test object within the
search area and then click on Test allin the toolbar. 

Check the test results and adjust the parameters if required.

8. Repeat step 7 as often as necessary to achieve an optimally set up
tracking.
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Notes and tips • The search algorithm tolerates brightness fluctuations. This is an advantage
with alternating object materials, object surfaces and non-homogeneous or
fluctuating lighting. You should, however, check that no unintentional mix-ups
with similar objects with another brightness occur.

• With a relatively low concurrence level (< 80%), faulty detections can in
particular occur with symmetrical objects with settings that are too coarse.
In this case improve the search accuracy via the parameters Search scale
accuracy and Search angle steps.

• If you only expect the object from one direction, you can reduce the
execution time by setting the Search angle range accordingly.

• Generally: Test your settings with practical tests under the most diverse
conditions as often as possible.

6.2.1.2 Tracking via Locate circle

Introduction The Locate circle function is one of the possible methods for tracking test
objects. It is a highly precise and fast tracking method, which, however, is
only suitable for rotation-stable objects. The function cannot record rotation
positions. Edge detection using a circle is the basis for this type of tracking.
 An algorithm searches here through the selected image area in a specified
direction line-by-line for big gray value differences among the pixels. If there is
a volatile gray value change, the pixels found are indicated as edge points. The
process is referred to as "Detection".A circle is then formed from these edge
points, whose centre point is used for the tracking.

Den Antastkreis wählen Sie über das Antastfenster Kreisringsegment aus.
Innerhalb dieser Fenster zeigt ein Antastpfeil die Richtung der Antastung
an. Diese können Sie umkehren, indem Sie mit der linken Maustaste auf
den Pfeil klicken (see "Detection area", Page 45). In dem Antastbereich
werden die einzelnen Kantenpunkte detektiert. Zur Nachführung wird aus
den Kantenpunkten jeweils ein Kreis (see "Formation of a circle to calculate
a reference circle from a scatter plot") erstellt, welche dann die jeweilige
Objektkante darstellt.

Parameters Edge transition

Via a drop-down menu you can specify here whether the gray value within the
detection area is to increase or decrease in the detection direction, so that an
edge point can be detected. The following two settings are possible:

• Bright → Dark With this setting only edge points on the intersections from
bright to dark gray values in the detection direction are detected and found.

• Dark → Bright With this setting only edge points on the intersections from
dark to bright gray values in the detection direction are detected and found.

The detection direction is an important factor for these parameters. You can find
any object edge with both possible settings if you change the detection direction
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accordingly. Note, however, that the edge intersections cannot be individually
adjusted for each detection area.

Edge filter size

Here you specify the accuracy of the line-by-line contour searches using a
sliding controller. The setting ranges from 0 (sharp edge) to 9 (fuzzy edge). The
coarser the filter value the more lines are pooled with the search, so that, under
certain circumstances, fine object edges can no longer be precisely detected.
A high filter setting does actually find more precise edges, but it also requires
a longer processing time for it. From filter value 2 upwards the sub-pixeling
(interpolation-calculation between the pixels) is activated to achieve higher
accuracy. Essentially you require both wide, fuzzy edges and a filter to achieve
greater accuracy.

Edge contrast

You enter the differential amount here, which is the least there must be in the
image with a gray value intersection so that an edge point can be found. The
edge contrast functions here as another filter, which sorts out all edges that
are not considered edge points because of their contrast, and therefore further
restricts the detection of an object edge. The settable value must be within the
gray value scale (1 ... 255) and the contrast ratios of the image are adjusted
so that an object edge can be successfully detected. With small brightness
differences (contrasts) in the image only edges with a lower edge contrast can
therefore be found.

A simplified example: If a dark object (gray value: 5) is against a bright
background (gray value: 212), then the edge contrast may not be set higher
than the differential amount 212 - 5 = 207, so that the object's edges can be
found. If you set the edge contrast to 220, the edge points and therefore the
object with its edges will not be found. If the gray value of the background
changes because of an adjusted lighting to 86, the edge contrast may not
exceed 86 - 5 = 81, so that the object is still found.

Edge completeness

Here you enter the minimum percentage of image lines that at least one edge
point must have so that an object edge is detected. You can consequently
specify how closed and therefore clear an edge must be in the image to be
detected as an applicable object edge. Pixel gaps, which can be caused by
possible image interferences between individual edge points, can also be
compensated and replaced with a certain tolerance. The edge completeness
always refers to the complete detection window. A measurement is also
performed if the detection window is partially outside the image. In this case
however, the edge completeness decreases according to how much of the
window is outside the image.

For better evaluation and error searches the calculated edge completeness
will be issued after every test process (Single test or Test all) in the results
window under the measurement results. If the specified edge completeness is
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not achieved with a function the following message appears under the value
– "Error: The edge completeness is below the reference value." and the test
process has failed.

Noise edge filter - First edge only

If you activate this checkbox the algorithm searches through every line of
the detection area until it finds the first object edge that corresponds with
the set parameters. If there are numerous interfering edges in the detection
area, this filter reduces the processing time significantly. If you deactivate the
checkbox, all edge points that apply for the existing parameters are detected
and processed.

Noise edge filter - Remove short edges 

If you activate this checkbox, individual edge points or smaller edges are
automatically ignored and filtered out. This interference filter is active by default.

Preview

In the preview you see the effect of the currently defined parameters and
specified detection areas at all times. The left window always shows the
detection area on the furtherest left here (furthest up with the same vertical
alignment). In both windows the detection area is shown black and is in front
of a blue background. Within the detection areas found edge points (gradients)
are shown in white (good edge contrast) to dark gray (bad edge contrast). They
point to the position where the gradient exceeds the edge contrast. If these
edge points correspond with the edge contrast parameters and are not sorted
out here by one of the interference filters, they are marked green. This means
that these edge points are applicable with a test process. The green marking
identifies the found edge points and entire edges here, to clearly show the
detected position with coarser edge filter settings. Edge points that are sorted
out by an interference filter are marked red and are not applicable with a test
process. The edge completeness parameter does not have any effect on the
display in the preview.

You can activate/deactivate the preview at all times by setting a checkmark with
Show preview. Deactivation reduces the time for parametering, as the device
does not have to generate a new preview for every adjustment.

Use the preview to optimise your parameter settings and to make the test
process more precise. If, for example, you increase the edge filer value, the
effect is immediately visible in the preview – sharp, white edges become
coarser and washy – and you can immediately see whether the edge to be
detected has been detected yet and at the right position. The selection and
strength of the filter depends on the respective object edge.
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Steps for setting up
tracking via Locate
circle

1. Click on the Tracking index card in the
tab area and then on the drop-down menu
in the Control area. Select Locate circle.

The parameter area appears in the
tabs.

2. Verschieben und skalieren Sie die Antastbereiche so (see "Geometrical
shapes and adjustment options", Page 46), dass diese die zwei anzu-
tastenden Kanten optimal umschließen. Stellen Sie sicher, dass sich so
wenig Störkanten wie möglich innerhalb der Antastbereiche befinden.
Check your adjustments via the preview.

3. Specify the direction of the gray value
intersection under Edge transition.
Adjust the direction of the detection arrow
accordingly. Note that both arrows must
point to the same gray value intersection.

4. Adjust the following parameters to your requirements:

• Edge filter value
• Edge contrast
• Edge completeness
• Noise edge filter - Only first edge
• Noise edge filter - Remove short edges

Check your settings via the preview.

5. In the camera image window activate the
result display under Show results for –
Selected function.

6. Click on the Single test button to test the tracking settings. 

a) If the test is successful, a blue cross marks the point found, the position
angle is displayed in x/y and the edges found are coloured blue.

b) If no edges or unwanted edges are found, correct the corresponding
parameters (see step 4) and/or the detection area (see step 2). Then
click on Single test again to check your changes. Repeat this step as
often as necessary.

7. Change the position and rotation position of the test object within the
search area and then click on Test allin the toolbar.

Check the test results and adjust the parameters or detection areas further
if required (steps 2 - 4).

6.2.1.3 Tracking via Locate corner

Introduction The Locate corner function is one of the possible methods for tracking test
objects. It is a highly precise and fast tracking method, which, however, is
only suitable for relatively position-stable objects. The function can no longer
record rotation positions greater than 45°, as the search in the image is not for
a unique pattern, but rather for two edges. This is based on edge detection.
 An algorithm searches here through the selected image area in a specified
direction line-by-line for big gray value differences among the pixels. If there is
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a volatile gray value change, the pixels found are indicated as edge points. A
straight line, which is suitable for the testing and evaluation, is then formed from
these where possible. The process is referred to as "Detection".

Die zwei Kanten wählen Sie über zwei Antastfenster aus. Innerhalb dieser
Fenster zeigt jeweils ein Antastpfeil die Richtung der Antastung an. Diese
können Sie umkehren, indem Sie mit der linken Maustaste auf den Pfeil
klicken (see "Detection area", Page 45). In den Antastbereichen werden die
einzelnen Kantenpunkte detektiert. Zur Messung wird aus den Kantenpunkten
jeweils eine Gerade (see "Straight line formation") erstellt, welche dann die
jeweilige Objektkante darstellt. Die Objektkanten werden über Hilfslinien
verlängert und Sie erhalten einen Schnittpunkt, an dem die Nachführung
letztendlich ausgerichtet wird.

Unter der Anzeigeoption Zeige Ergebnisse für - Ausgewählte Funktion (see
"Camera Image", Page 32) können Sie sich diese Hilfslinien visuell darstellen
lassen. Die Lage definiert sich dann über den Winkel der Winkelhalbierenden
zur y-Achse des Koordinatensystems. Die angetastete Ecke muss also nicht
tatsächlich im Bild existieren, um das Objekt nachzuführen, sondern beschreibt
nur den Schnittpunkt zwischen zwei Geraden.

Parameters Edge transition

Via a drop-down menu you can specify here whether the gray value within the
detection area is to increase or decrease in the detection direction, so that an
edge point can be detected. The following two settings are possible:

• Bright → Dark With this setting only edge points on the intersections from
bright to dark gray values in the detection direction are detected and found.

• Dark → Bright With this setting only edge points on the intersections from
dark to bright gray values in the detection direction are detected and found.

The detection direction is an important factor for these parameters. You can find
any object edge with both possible settings if you change the detection direction
accordingly. Note, however, that the edge intersections cannot be individually
adjusted for each detection area.

Edge filter size

Here you specify the accuracy of the line-by-line contour searches using a
sliding controller. The setting ranges from 0 (sharp edge) to 9 (fuzzy edge). The
coarser the filter value the more lines are pooled with the search, so that, under
certain circumstances, fine object edges can no longer be precisely detected.
A high filter setting does actually find more precise edges, but it also requires
a longer processing time for it. From filter value 2 upwards the sub-pixeling
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(interpolation-calculation between the pixels) is activated to achieve higher
accuracy. Essentially you require both wide, fuzzy edges and a filter to achieve
greater accuracy.

Edge contrast

You enter the differential amount here, which is the least there must be in the
image with a gray value intersection so that an edge point can be found. The
edge contrast functions here as another filter, which sorts out all edges that
are not considered edge points because of their contrast, and therefore further
restricts the detection of an object edge. The settable value must be within the
gray value scale (1 ... 255) and the contrast ratios of the image are adjusted
so that an object edge can be successfully detected. With small brightness
differences (contrasts) in the image only edges with a lower edge contrast can
therefore be found.

A simplified example: If a dark object (gray value: 5) is against a bright
background (gray value: 212), then the edge contrast may not be set higher
than the differential amount 212 - 5 = 207, so that the object's edges can be
found. If you set the edge contrast to 220, the edge points and therefore the
object with its edges will not be found. If the gray value of the background
changes because of an adjusted lighting to 86, the edge contrast may not
exceed 86 - 5 = 81, so that the object is still found.

Edge completeness

Here you enter the minimum percentage of image lines that at least one edge
point must have so that an object edge is detected. You can consequently
specify how closed and therefore clear an edge must be in the image to be
detected as an applicable object edge. Pixel gaps, which can be caused by
possible image interferences between individual edge points, can also be
compensated and replaced with a certain tolerance. The edge completeness
always refers to the complete detection window. A measurement is also
performed if the detection window is partially outside the image. In this case
however, the edge completeness decreases according to how much of the
window is outside the image.

For better evaluation and error searches the calculated edge completeness
will be issued after every test process (Single test or Test all) in the results
window under the measurement results. If the specified edge completeness is
not achieved with a function the following message appears under the value
– "Error: The edge completeness is below the reference value." and the test
process has failed.

Noise edge filter - First edge only

If you activate this checkbox the algorithm searches through every line of
the detection area until it finds the first object edge that corresponds with
the set parameters. If there are numerous interfering edges in the detection
area, this filter reduces the processing time significantly. If you deactivate the
checkbox, all edge points that apply for the existing parameters are detected
and processed.
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Noise edge filter - Remove short edges 

If you activate this checkbox, individual edge points or smaller edges are
automatically ignored and filtered out. This interference filter is active by default.

Preview

In the preview you see the effect of the currently defined parameters and
specified detection areas at all times. The left window always shows the
detection area on the furtherest left here (furthest up with the same vertical
alignment). In both windows the detection area is shown black and is in front
of a blue background. Within the detection areas found edge points (gradients)
are shown in white (good edge contrast) to dark gray (bad edge contrast). They
point to the position where the gradient exceeds the edge contrast. If these
edge points correspond with the edge contrast parameters and are not sorted
out here by one of the interference filters, they are marked green. This means
that these edge points are applicable with a test process. The green marking
identifies the found edge points and entire edges here, to clearly show the
detected position with coarser edge filter settings. Edge points that are sorted
out by an interference filter are marked red and are not applicable with a test
process. The edge completeness parameter does not have any effect on the
display in the preview.

You can activate/deactivate the preview at all times by setting a checkmark with
Show preview. Deactivation reduces the time for parametering, as the device
does not have to generate a new preview for every adjustment.

Use the preview to optimise your parameter settings and to make the test
process more precise. If, for example, you increase the edge filer value, the
effect is immediately visible in the preview – sharp, white edges become
coarser and washy – and you can immediately see whether the edge to be
detected has been detected yet and at the right position. The selection and
strength of the filter depends on the respective object edge.
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Steps for setting up
tracking via Locate
corner

1. Click on the Tracking index card in the
tab area and then on the drop-down menu
in the Control area. Select Locate corner.

The parameter area appears in the
tabs.

2. Verschieben und skalieren Sie die Antastbereiche so (see "Geometrical
shapes and adjustment options", Page 46), dass diese die zwei anzu-
tastenden Kanten optimal umschließen. Stellen Sie sicher, dass sich so
wenig Störkanten wie möglich innerhalb der Antastbereiche befinden.
Check your adjustments via the preview.

3. Specify the direction of the gray value
intersection under Edge transition.
Adjust the direction of the detection arrow
accordingly. Note that both arrows must
point to the same gray value intersection.

4. Adjust the following parameters to your requirements:

• Edge filter value
• Edge contrast
• Edge completeness
• Noise edge filter - Only first edge
• Noise edge filter - Remove short edges

Check your settings via the preview.

5. In the camera image window activate the
result display under Show results for –
Selected function.

6. Click on the Single test button to test the tracking settings. 

• If the test is successful, a blue arrow marks the intersection point found,
the position angle is displayed and the edges found are coloured blue
and extended.

• If no edges or unwanted edges are found, correct the corresponding
parameters (see step 4) and/or the detection areas (see step 2). Then
click on Single test again to check your changes. Repeat this step as
often as necessary.

7. Change the position and rotation position of the test object within the
search area and then click on Test allin the toolbar.

Check the test results and adjust the parameters or detection areas further
if required (steps 2 - 4).

6.2.2 Pattern search

Introduction The Pattern search function is used to classify objects in any kind of developed
environment. It is based on the correlation search method, which compares
image features. These features must be first extracted from the available test
object image to be digitally taught-in and stored as a pattern. After the features
have been taught in the "Correlation" search method can search through any
image on the digitally stored pattern, and with a find determine its position. With
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a set-up tracking the determined positions and rotation positions apply to the
tracking. A concurrence level indicates if and how precisely a pattern has been
found, and also decides on the result of the function.

The Pattern search function is especially suitable for application in installation
checks or for differentiating between component shapes.

ADVICE
If the Pattern search function is added to the list of functions and evaluated,
in contrast to the tracking via Pattern search the determined position or
rotation position has no further effect on the other functions.

Parameters You can set the following parameters:

Teach area type

Via a drop-down menu you can specify the geometrical shape you want for the
Teach area here. You will find more information on the image processing areas
in section. "Image processing areas", Page 43

Displayed pattern

Here you can select whether the taught-in pattern is to be displayed in the
lowest (Presearch), highest (Fine search) or original resolution. The Presearch
here represents the pattern with the coarsest search accuracy. This serves
to determine if the pattern to be searched is detectable. The "Fine search"
then shows the pattern as it is also found with search method concurrence.
Both displays change accordingly with an adjustment of the "Search accuracy"
parameter.

Search scale accuracy

Here you specify the accuracy of the search method using a sliding controller.
The finer the accuracy is set, the better fine-structured objects or patterns
will be found. A coarser search by comparison requires less processing time.
Find the optimum setting by trying out different levels of fineness and observe
the corresponding resolutions in the pattern display as you do so. The search
accuracy setting should also be verified with different rotation positions of the
pattern.

The search algorithm begins its calculations on a very coarse image and tracks
the pattern found up to here up to a certain point in a somewhat finer image.
With a very fine setting the position found is then pixel-accurate; with a coarser
one the corresponding position can, however, only be determined in specific
increments. The processing time, however, is significantly reduced because of
the lower data volume.
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Pixel precise position correction

If you activate this checkbox, with a successful pattern search a pixel-accurate
search of the respective x/y position is performed. You receive a precise
position value for the object found. This setting, however, means a longer test
method processing time.

Search angle steps

Here you can enter the value of the increment with which the algorithm
searches the taught-in pattern in the given search angle range. The value can
be specified either via the sliding controller or direct value entry. The lowest
possible setting is 1°; the highest is 90°. The set angle shows that the pattern
is rotated in the corresponding ° steps and searched for in the selected search
area of the image. A higher search angle increment enables faster processing,
while a lower one increases the search accuracy.

Search angle range

You can provide the angle range here in which the pattern is to be found.
This means, for example, that an object is only detected in a specific rotation
position or it can only be fed into the test in a specific test process-conditional
rotation position. As all possible positions and angles of rotation of the pattern
are searched for in the image with the pattern search, the amount of possible
combinations plays a decisive role for the processing time. With twice as big
a search angle range, you therefore generally get twice the processing time.
Furthermore with circular-symmetrical objects the pattern must also be found in
a complete 360° search, which the following example explains.

The red angle range is symmetrical to the blue angle
range. As the object consists of 16 such areas, a
search must now only be made in the angle range
360°/16 = 22.5°. The processing time decreases signifi-
cantly.

To set the search angle you can raise the angle range with the red and green
balls. To do this click on the respective ball and move in the direction you want
with pressed mouse button. The blue marking shows the angle range covered.
A direct value entry with the parameters "From / To" is also possible in the two
fields on the right.
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Minimum Match

You can enter the level of similarity that must be achieved with the pattern
comparison here, so that the pattern is marked as found and the tracking was
successful. The entry is in percentage and should not be selected too low.
Values of more than 75% are proven settings in everyday industrial work.

Search area type

Via a drop-down menu you can specify the geometrical shape you want for the
Search area here. You will find more information on the image processing areas
in section "Image processing areas", Page 43.

Object may exceed search area

If you activate this checkbox the object may exceed out of the search area with
up to 25% of its area and is still found. This is especially beneficial with the
possibility that test objects under certain circumstances are not always within
the search area because of position instability or inaccurate provision. This
setting, however, means a longer test method processing time.
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Steps for setting up
the Pattern search
function

1. Click on the Functions index card in the
tab area and then on Add.

In the selection menu select the Pattern
search entry and give the function a name
in the text field below it. Confirm with OK.

The function appears in the function list
and the parameters area is shown.

2. Under Teach area type select the
geometrical shape for the teach area type
and in the image surround the area to be
tested as best possible with the border of
the inspection area. Then click on Teach.

The marked pattern is taught in and
shown in the pattern display.

3. Under Search area type select the
geometrical shape for the search area and
in the camera image surround the area to
be tested as best possible with the border
of the inspection area.

4. Adjust the following parameters to your requirements:

• Search scale accuracy
• Search angle steps
• Search angle range
• Minimum match
• Pixel precise position correction
• Object may exceed search area

5. Click on the Single test button to test the function's settings. 

If the achieved concurrence is too low, increase the search accuracy by
adjusting the corresponding parameters. Then click on Single test again to
check your changes.

6. Change the position and rotation position of the test object within the
search area and then click on Test allin the toolbar. 

Check the test results and adjust the parameters if required.

7. Repeat step 6 as often as possible to be sure that the object can be found
with sufficient match.
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Notes and tips • The search algorithm tolerates brightness fluctuations. This is an advantage
with alternating object materials, object surfaces and non-homogeneous or
fluctuating lighting. You should, however, check that no unintentional mix-ups
with similar objects with another brightness occur.

• With a relatively low concurrence level (< 80%), faulty detections can in
particular occur with symmetrical objects with settings that are too coarse.
In this case improve the search accuracy via the parameters Search scale
accuracy and Search angle steps.

• If you only expect the object from one direction, you can reduce the
execution time by setting the Search angle range accordingly.

• Generally: Test your settings with practical tests under the most diverse
conditions as often as possible.

6.2.3 Area test

Introduction The Area test function counts the number of pixels in a defined gray value
area within the test area and marks it with the blue recognition area. If the
determined number of detected pixels is in the specified surface area, the
test process is successful; otherwise it has failed. This auto function enables
automatic parametering based on the current image. The Area test function is
especially suitable for completeness checks and surface tests.

Parameters The following parameters can be set:

Inspection area type

Via a selection list you specify
the geometrical shape you want for the "Inspection area" here. You will find
more information on the image processing areas in section, "Image processing
areas", Page 43.

Gray value range

Here you define the gray value area inside which the pixels of an area are
to be counted. The gray value range setting allows a upper and a lower limit
here. The minimum value that can be set is 0; the highest value that can be set
corresponds with the maximum brightness 255. You can parameter the gray
value area either manually via the direct value entry or the histogram below it.
The Auto function is the third variant.

The histogram illustrates the frequency distribution of the individual gray values
from 0 to 255 in the test area and at the same time enables the limits to be
defined via movable lines. The red line marks the upper limit; the green line the
lower one. The restricted gray value area is coloured blue. To move the limits
click on a line and move it in the direction you want with pressed mouse button.
The current gray values can be read and refined via the value entry fields.



metimus 1.7.0.6
Part 3 – Introduction to Functions and Function Reference

© Vision & Control GmbH
2018

999.994.424.10-en-1.0 69

Valid area range

Via two value entries you can specify the pixel number limits here and therefore
define the pixel area within which the function is to be rated as successful.
With pixel numbers found to be above or below these limits, the function is
considered to have failed. The maximum reference value that can be set
corresponds with the number of pixels of a full image (resolution in x multiplied
by resolution in y).
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Steps for setting up
the Area test function

1. Click on the Functions index card in the
tab area and then on Add. 

In the selection menu select the Area test
entry and give the function a name in the
text field below it. Confirm with OK.

The function appears in the function list
and the parameters area is shown.

2. Under Test area type select the geomet-
rical shape for the test area and in the
image surround the area to be tested as
best possible with the border of the test
area.

3. Enter the Gray value range via the value
entry or shift the lines in the histogram to
define the gray value area. Alternatively
click on Auto Adjust so that the vision
system determines a suitable gray value
area setting. 

The new setting is then automatically
checked with an single test.

4. Click on the Single test button to check the set gray value area. 

You can evaluate the set gray value range on the basis of the recognition
area. If only the test object is shown completely blue, the settings are in
a suitable range. If, on the other hand, the background is marked blue or
parts of the test object are not marked blue, repeat step 3.

5. Enter the Valid area range via the value
entry to specify a tolerance range for the
pixel numbers. Use the number of found
pixels of the single test from step 4 for
this.

6. Click again on the Single test button to check if the function was rated
successful and that the number of pixels is in the specified pixel number
range. 

If not you must adjust your parameter settings (step 5).

Notes and tips • Depending on the brightness of the object you should select a low range for
dark objects and a high range for bright objects for the gray value range, in
order to guarantee optimum object recognition.
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6.2.4 Gray value test

Introduction The Gray value test function is a quick and easy command for determining the
mean gray value within a defined inspection area. All gray values of the pixels
in the inspection area are recorded and a mean value is formed, which must
be within a certain tolerance range, so that the function is rated as successful.
This auto function enables automatic parametering based on the current image.
The gray value test can be set very differently, e.g. for the presence checks of
simple objects (gray value difference between background and object) or for
attributive tests (bright / gray / dark part).

Parameters You can set the following parameters:

Inspection area type

Via a selection list you specify
the geometrical shape you want for the "Inspection area" here. You will find
more information on the image processing areas in section, "Image processing
areas", Page 43.

Gray value range

Here you can define the gray value thresholds between which the mean gray
value of all pixels in the inspection area must be, so that the function is rated
successful. The minimum value that can be set is 0; the highest value that can
be set corresponds with the maximum brightness 255. You can parameter the
gray value area either via direct value entry and the histogram under it or use
the Auto function.

The histogram illustrates the frequency distribution of the individual gray values
from 0 to 255 in the inspection area and at the same time enables the limits
to be defined via movable lines. The red line marks the upper limit; the green
line the lower one. The restricted gray value area is coloured blue. To move the
limits click on a line and move it in the direction you want with pressed mouse
button. The current gray values can be read and refined via the value entry
fields.
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Steps for setting up
the gray value test
function

1. Click on the Functions index card in the
tab area and then on Add. 

In the selection menu select the Gray
value test entry and give the function a
name in the text field below it. Confirm
with OK.

The function appears in the function list
and the parameters area is shown.

2. Under Inspection area type select the
geometrical shape for the inspection area
and in the image surround the area to be
tested as best possible with the border of
the inspection area.

3. Adjust the Gray value range parameter
to your requirements. Enter the limits in
the value fields or shift the lines in the
histogram to do this. Alternatively click on
Auto Adjust to have a suitable gray value
area setting determined by the sensor. 

The new setting is then automatically
checked with a single test.

4. Click on the Single test button to check the set gray value area and to find
out if the function will be displayed as successful.

Repeat step 3 if it is displayed as failed.

6.2.5 Brightness percentage

Introduction The Brightness percentage function determines the number of pixels in %
within the inspection area, which are above a set gray value threshold in their
gray value. The function then applies as successful when the found % of bright
pixels is within a defined tolerance range. This auto function enables automatic
parametering based on the current image. It is suitable for surface checks,
presence tests and contrast checks.

Parameters You can set the following parameters:

Inspection area type

Via a selection list you specify
the geometrical shape you want for the "Inspection area" here. You will find
more information on the image processing areas in section, "Image processing
areas", Page 43.
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Gray value threshold

Here you can define the gray value threshold after which a pixel is classified as
a bright pixel. The minimum value that can be set is 0; the highest value that
can be set corresponds with the maximum brightness 255. You can parameter
the gray value area either via direct value entry and the histogram under it or
use the Auto function. The Auto function is the third variant.

The histogram illustrates the frequency distribution of the individual gray values
from 0 to 255 in the inspection area and at the same time enables the threshold
to be defined via a movable green line. To change the threshold click on the
green line and move it in the direction you want with pressed mouse button. The
current gray value can be read and refined via the value entry fields.

Range

Here you can define the tolerance limits in %, between which the determined
percentage of bright pixels must be so that the function is rated successful.
If the percentage is above or below these limits, the function has failed. You
specify the limits via a value entry.
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Steps for setting
up the brightness
percentage function

1. Click on the Functions index card in the
tab area and then on Add.

In the selection menu select the Bright-
ness Percentage entry and give the
function a name in the text field below it.
Confirm with OK.

The function appears in the function list
and the parameters area is shown.

2. Under Inspection Area Type select the
geometrical shape for the inspection area
and in the image surround the area to be
tested as best possible with the border of
the inspection area.

3. You specify the Gray Value Threshold
via the direct value entry or the histogram.
To do this check the different gray values
of the object within the camera image by
moving the cursor over it. Alternatively
click on Auto Adjust to have a suitable
gray value area setting determined by the
sensor. 

The new setting is then automatically
checked with an single test.

4. Click on the Single Test to check the set gray value threshold. 

On the basis of the displayed recognition area (blue overlay), you can
decide if the inspection area that you want to evaluate has been sufficiently
found. If not repeat step 3.

5. Define the lower and upper Range via the
value entry. Use the function result of the
single test from step 4 for this.

6. Click again on the Single Test button to check if the function is displayed
as successful and the tolerance range has been sufficiently parametered.

If not you must adjust your parameter settings (step 5).

6.2.6 Edge position

Introduction The edge position function measures and checks different distance types
between an object edge and a reference line. The reference line is a defined,
fixed determined object edge, which you can rotate and align in any way you
want together with the detection window. You select the edge to be detected via
a detection area that can be moved to the reference line, in which the individual
edge points are detected. After a test the edge points found are marked blue in
the camera image.
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Unter der Anzeigeoption Zeige Ergebnisse für - Ausgewählte Funktion
(see "Camera Image", Page 32) können Sie sich für die Messergebnisse
blaue Hilfslinien anzeigen lassen, die Ihnen den gemessenen Abstand und
die Hilfsgeraden zur Kantenerkennung visuell darstellen. Sie können im
Gegensatz zur Funktion Messschieber mit dieser Funktion nur die minimale
Distanz, die maximale Distanz, den Durchschnitt und die Materialdicke messen,
welche im Abschnitt Distanztypen einzeln beschrieben werden. Die Funktion
Kantenposition eignet sich besonders für Messungen der Koplanarität.

Parameters Edge transition

Via a drop-down menu you can specify here whether the gray value within the
detection area is to increase or decrease in the detection direction, so that an
edge point can be detected. The following two settings are possible:

• Bright → Dark With this setting only edge points on the intersections from
bright to dark gray values in the detection direction are detected and found.

• Dark → Bright With this setting only edge points on the intersections from
dark to bright gray values in the detection direction are detected and found.

The detection direction is an important factor for these parameters. You can find
any object edge with both possible settings if you change the detection direction
accordingly. Note, however, that the edge intersections cannot be individually
adjusted for each detection area.

Edge filter size

Here you specify the accuracy of the line-by-line contour searches using a
sliding controller. The setting ranges from 0 (sharp edge) to 9 (fuzzy edge). The
coarser the filter value the more lines are pooled with the search, so that, under
certain circumstances, fine object edges can no longer be precisely detected.
A high filter setting does actually find more precise edges, but it also requires
a longer processing time for it. From filter value 2 upwards the sub-pixeling
(interpolation-calculation between the pixels) is activated to achieve higher
accuracy. Essentially you require both wide, fuzzy edges and a filter to achieve
greater accuracy.

Edge contrast

You enter the differential amount here, which is the least there must be in the
image with a gray value intersection so that an edge point can be found. The
edge contrast functions here as another filter, which sorts out all edges that
are not considered edge points because of their contrast, and therefore further
restricts the detection of an object edge. The settable value must be within the
gray value scale (1 ... 255) and the contrast ratios of the image are adjusted
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so that an object edge can be successfully detected. With small brightness
differences (contrasts) in the image only edges with a lower edge contrast can
therefore be found.

A simplified example: If a dark object (gray value: 5) is against a bright
background (gray value: 212), then the edge contrast may not be set higher
than the differential amount 212 - 5 = 207, so that the object's edges can be
found. If you set the edge contrast to 220, the edge points and therefore the
object with its edges will not be found. If the gray value of the background
changes because of an adjusted lighting to 86, the edge contrast may not
exceed 86 - 5 = 81, so that the object is still found.

Edge completeness

Here you enter the minimum percentage of image lines that at least one edge
point must have so that an object edge is detected. You can consequently
specify how closed and therefore clear an edge must be in the image to be
detected as an applicable object edge. Pixel gaps, which can be caused by
possible image interferences between individual edge points, can also be
compensated and replaced with a certain tolerance. The edge completeness
always refers to the complete detection window. A measurement is also
performed if the detection window is partially outside the image. In this case
however, the edge completeness decreases according to how much of the
window is outside the image.

For better evaluation and error searches the calculated edge completeness
will be issued after every test process (Single test or Test all) in the results
window under the measurement results. If the specified edge completeness is
not achieved with a function the following message appears under the value
– "Error: The edge completeness is below the reference value." and the test
process has failed.

Noise edge filter - First edge only

If you activate this checkbox the algorithm searches through every line of
the detection area until it finds the first object edge that corresponds with
the set parameters. If there are numerous interfering edges in the detection
area, this filter reduces the processing time significantly. If you deactivate the
checkbox, all edge points that apply for the existing parameters are detected
and processed.

Noise edge filter - Remove short edges 

If you activate this checkbox, individual edge points or smaller edges are
automatically ignored and filtered out. This interference filter is active by default.

Noise edge filter - Next to line only

Here you define a both-sided distance from the main edge, outside of which all
edge points found are ignored and are not processed and displayed as function
result. You can consequently remove irrelevant and measurement error-causing
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edge points, to receive exact and clear measurement results. The distance can
be entered via a values field in [mm].

Distance type

Via the drop-down menu you specify the distance types to be measured here.
To select are: absolute maximum, absolute minimum, opening maximum,
opening minimum, average and material thickness. You will find descriptions for
individual types in the following section, Distance types.

Distance range

Via the two value entries Lower and Upper you specify the tolerance limits
in [mm] here, and therefore define the measurement area, within which the
measured distance must be so that the function is rated successful. With a
distance found to be above or below these limits, the function is considered to
have failed.

Preview

In the preview you see the effect of the currently defined parameters and the
specified detection area at all times. The detection area is shown black and is
in front of a blue background. Within the detection area found edge points are
shown in white (good edge contrast) to dark gray (bad edge contrast). If these
edge points correspond with the edge contrast parameters and are not sorted
out here by one of the interference filters, they are marked green. This means
that these edge points are applicable with a test process. The green marking
identifies the found edge points and entire edges here, to clearly show the
detected position with coarser edge filter settings. Edge points that are sorted
out by an interference filter are marked red and are not applicable with a test
process. The edge completeness parameter does not have any effect on the
display in the preview.

Use the preview to optimise your parameter settings and to both speed up and
make the test process more precise. If, for example, you increase the edge filer
value, the effect is immediately visible in the preview – white edges become
coarser and washy – and you can immediately see whether the edge to be
detected has been detected yet and at the right position.
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Distance types Absolute minimum

The "Absolute minimum" distance type determines the position and the value
for the smallest possible distance between two edges and their edge points. All
possible distances between the found edge points of the two detection areas
are calculated for this and the smallest found value is then issued as the result.
In comparison this distance type requires a relatively high processing time, as
all possible pixel combinations are worked out.

Absolute maximum

The "Absolute maximum" distance type determines the position and the value
for the biggest possible distance between two edges and their edge points. All
possible distances between the found edge points of the two detection areas
are calculated for this and the highest found value is then issued as the result.
In comparison this distance type requires a relatively high processing time, as
all possible pixel combinations are worked out.

Opening minimum

The opening minimum distance type determines the position and the value
for the smallest opening between two object edges and is therefore especially
suitable for thickness measurements. For the measurement one straight help
line each is created for this from the found edge points of the detection areas.
The straight help lines are formed according to the principle of the smallest
error squares (see "Straight line formation", Page 116), with which additional
outliers are ignored to get the straightest possible edge run. Depending on the
quality either the straight help line with the better straightness is used for the
measurement or a straight line of symmetry, which is created from both straight
help lines. From the straight line used all distances are measured orthogonally
to opposing edge points and the opening minimum is determined from this, i.e.
the smallest distance between the straight line and an edge point. For better
visualisation you can have the determined opening displayed via two blue lines
("Show results for" option).
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Opening maximum

The "Opening maximum" distance type determines the position and the value
for the biggest opening between two object edges and is therefore especially
suitable for thickness measurements. For the measurement one straight help
line each is created for this from the found edge points of the detection areas.
The straight help lines are formed according to the principle of the smallest
error squares (see "Straight line formation", Page 116), with which additional
outliers are ignored to get the straightest possible edge run. Depending on the
quality either the straight help line with the better straightness is used for the
measurement or a straight line of symmetry, which is created from both straight
help lines. From the straight line used all distances are measured orthogonally
to opposing edge points and the opening maximum is determined from this,
i.e. the biggest distance between the straight line and an edge point. For better
visualisation you can have the determined opening displayed via two blue lines
("Show results for" option).

Average

The "Average" distance type determines the value for the average opening
between two object edges. For the measurement one straight help line each is
created for this from the found edge points of the detection areas. The straight
help lines are formed according to the principle of the smallest error squares
(see "Straight line formation", Page 116), with which additional outliers are
ignored to get the straightest possible edge run. Depending on the quality either
the straight help line with the better straightness is used for the measurement
or a straight line of symmetry, which is created from both straight help lines.
From the straight line used all distances are measured orthogonally to opposing
edge points and an average value is calculated from this, which describes the
average opening. For better visualisation you can have the determined average
opening displayed via two blue lines ("Show results for" option).

Material thickness

The "Material thickness" distance type determines the smallest distance
(minimum) for each individual edge point to another edge point of the opposing
detection area. It is then checked if all determined distances are within the
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set measurement area (distance limits). The smallest found distance and the
biggest found distance of all minima are issued as specific function values. This
distance type is especially suitable for thickness measurement, but it requires a
relatively long processing time.

Steps for setting up
the Edge position
function

1. Click on the Functions index card in the
tab area and then on Add.

In the selection menu select the Edge
position entry and give the function a
name in the text field below it. Confirm
with OK.

The function appears in the function list
and the parameters area is shown.

2. Move and scale the detection area (see "Detection area", Page 45) so
that it optimally surrounds the edge to be detected. Then position the refer-
ence line. Ensure that as few interference edges as possible are in the
detection area.
Check your adjustments via the preview.

3. Specify the direction of the gray value
intersection under Edge transition.
Adjust the direction of the detection arrow
accordingly.

4. Adjust the following parameters to your requirements:

• Edge filter value
• Edge contrast
• Edge completeness
• First edge only
• Remove short edges
• Edges Next to Line only

Check your settings via the preview.

5. Under Distance type select the distance
type to be measured.
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6. In the camera image window activate the
result display under Show results for –
Selected function.

7. Click on the Single test button to test the parameter settings.

a) If applicable edges have been found, the result value of the measure-
ment is shown and the distance found is shown in blue.

b) If no object edges or required object edge are not found, correct the
corresponding parameters (see step 4) and/or the detection area (see
step 2). Then click on Single test again to check your changes. Repeat
this step as often as necessary.

8. Define the lower and upper distance
range via the values entry. Use the func-
tion result of the single test from step 7 for
this.

9. Click on the Single test button to check the set distance rangeand to find
out if the function will be displayed as successful.

6.2.7 Caliper

Introduction The caliper function measures and checks different distance types between two
object edges. You select the object edges via two detection areas that can be
moved to each other, in which the individual edge points are detected. After a
test the edge points found are marked blue in the camera image.

Under the display option Show results for - selected function (see "Camera
Image", Page 32) you can have blue help lines displayed for the measurement
results, which visually show you the measured distance and/or straight help
lines for the edge recognition. With this function you can measure a total of six
different distances, which are described individually in section, Distance types.

Parameters Edge transition

Via a drop-down menu you can specify here whether the gray value within the
detection area is to increase or decrease in the detection direction, so that an
edge point can be detected. The following two settings are possible:

• Bright → Dark With this setting only edge points on the intersections from
bright to dark gray values in the detection direction are detected and found.

• Dark → Bright With this setting only edge points on the intersections from
dark to bright gray values in the detection direction are detected and found.

The detection direction is an important factor for these parameters. You can find
any object edge with both possible settings if you change the detection direction
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accordingly. Note, however, that the edge intersections cannot be individually
adjusted for each detection area.

Edge filter size

Here you specify the accuracy of the line-by-line contour searches using a
sliding controller. The setting ranges from 0 (sharp edge) to 9 (fuzzy edge). The
coarser the filter value the more lines are pooled with the search, so that, under
certain circumstances, fine object edges can no longer be precisely detected.
A high filter setting does actually find more precise edges, but it also requires
a longer processing time for it. From filter value 2 upwards the sub-pixeling
(interpolation-calculation between the pixels) is activated to achieve higher
accuracy. Essentially you require both wide, fuzzy edges and a filter to achieve
greater accuracy.

Edge contrast

You enter the differential amount here, which is the least there must be in the
image with a gray value intersection so that an edge point can be found. The
edge contrast functions here as another filter, which sorts out all edges that
are not considered edge points because of their contrast, and therefore further
restricts the detection of an object edge. The settable value must be within the
gray value scale (1 ... 255) and the contrast ratios of the image are adjusted
so that an object edge can be successfully detected. With small brightness
differences (contrasts) in the image only edges with a lower edge contrast can
therefore be found.

A simplified example: If a dark object (gray value: 5) is against a bright
background (gray value: 212), then the edge contrast may not be set higher
than the differential amount 212 - 5 = 207, so that the object's edges can be
found. If you set the edge contrast to 220, the edge points and therefore the
object with its edges will not be found. If the gray value of the background
changes because of an adjusted lighting to 86, the edge contrast may not
exceed 86 - 5 = 81, so that the object is still found.

Edge completeness

Here you enter the minimum percentage of image lines that at least one edge
point must have so that an object edge is detected. You can consequently
specify how closed and therefore clear an edge must be in the image to be
detected as an applicable object edge. Pixel gaps, which can be caused by
possible image interferences between individual edge points, can also be
compensated and replaced with a certain tolerance. The edge completeness
always refers to the complete detection window. A measurement is also
performed if the detection window is partially outside the image. In this case
however, the edge completeness decreases according to how much of the
window is outside the image.

For better evaluation and error searches the calculated edge completeness
will be issued after every test process (Single test or Test all) in the results
window under the measurement results. If the specified edge completeness is
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not achieved with a function the following message appears under the value
– "Error: The edge completeness is below the reference value." and the test
process has failed.

Noise edge filter - First edge only

If you activate this checkbox the algorithm searches through every line of
the detection area until it finds the first object edge that corresponds with
the set parameters. If there are numerous interfering edges in the detection
area, this filter reduces the processing time significantly. If you deactivate the
checkbox, all edge points that apply for the existing parameters are detected
and processed.

Noise edge filter - Remove short edges 

If you activate this checkbox, individual edge points or smaller edges are
automatically ignored and filtered out. This interference filter is active by default.

Noise edge filter - Next to line only

Here you define a both-sided distance from the main edge, outside of which all
edge points found are ignored and are not processed and displayed as function
result. You can consequently remove irrelevant and measurement error-causing
edge points, to receive exact and clear measurement results. The distance can
be entered via a values field in [mm].

Distance type

Via the drop-down menu you specify the distance types to be measured here.
To select are: absolute maximum, absolute minimum, opening maximum,
opening minimum, average and material thickness. You will find descriptions for
individual types in the following section, Distance types.

Distance range

Via the two value entries Lower and Upper you specify the tolerance limits
in [mm] here, and therefore define the measurement area, within which the
measured distance must be so that the function is rated successful. With a
distance found to be above or below these limits, the function is considered to
have failed.



metimus 1.7.0.6
Part 3 – Introduction to Functions and Function Reference

84 999.994.424.10-en-1.0 © Vision & Control GmbH 2018

Preview

In the preview you see the effect of the currently defined parameters and
specified detection areas at all times. The left window always shows the
detection area on the furtherest left here (furthest up with the same vertical
alignment). In both windows the detection area is shown black and is in front
of a blue background. Within the detection areas found edge points (gradients)
are shown in white (good edge contrast) to dark gray (bad edge contrast). They
point to the position where the gradient exceeds the edge contrast. If these
edge points correspond with the edge contrast parameters and are not sorted
out here by one of the interference filters, they are marked green. This means
that these edge points are applicable with a test process. The green marking
identifies the found edge points and entire edges here, to clearly show the
detected position with coarser edge filter settings. Edge points that are sorted
out by an interference filter are marked red and are not applicable with a test
process. The edge completeness parameter does not have any effect on the
display in the preview.

You can activate/deactivate the preview at all times by setting a checkmark with
Show preview. Deactivation reduces the time for parametering, as the device
does not have to generate a new preview for every adjustment.

Use the preview to optimise your parameter settings and to make the test
process more precise. If, for example, you increase the edge filer value, the
effect is immediately visible in the preview – sharp, white edges become
coarser and washy – and you can immediately see whether the edge to be
detected has been detected yet and at the right position. The selection and
strength of the filter depends on the respective object edge.

Distance types Absolute minimum

The Absolute minimum distance type determines the position and the value
for the smallest possible distance between two edges and their edge points. All
possible distances between the found edge points of the two detection areas
are calculated for this and the smallest found value is then issued as the result.
In comparison this distance type requires a relatively high processing time, as
all possible pixel combinations are worked out.
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Absolute maximum

The Absolute maximum distance type determines the position and the value
for the biggest possible distance between two edges and their edge points. All
possible distances between the found edge points of the two detection areas
are calculated for this and the highest found value is then issued as the result.
In comparison this distance type requires a relatively high processing time, as
all possible pixel combinations are worked out.

Opening minimum

The Opening minimum distance type determines the position and the value
for the smallest opening between two object edges and is therefore especially
suitable for thickness measurements. For the measurement one straight help
line each is created for this from the found edge points of the detection areas.
The straight help lines are formed according to the principle of the smallest
error squares (see "Straight line formation", Page 116), with which additional
outliers are ignored to get the straightest possible edge run. Depending on the
quality either the straight help line with the better straightness is used for the
measurement or a straight line of symmetry, which is created from both straight
help lines. From the straight line used all distances are measured orthogonally
to opposing edge points and the opening minimum is determined from this, i.e.
the smallest distance between the straight line and an edge point. For better
visualisation you can have the determined opening displayed via two blue lines
("Show results for" option).
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Opening maximum

The Opening maximum distance type determines the position and the value
for the biggest opening between two object edges and is therefore especially
suitable for thickness measurements. For the measurement one straight help
line each is created for this from the found edge points of the detection areas.
The straight help lines are formed according to the principle of the smallest
error squares (see "Straight line formation", Page 116), with which additional
outliers are ignored to get the straightest possible edge run. Depending on the
quality either the straight help line with the better straightness is used for the
measurement or a straight line of symmetry, which is created from both straight
help lines. From the straight line used all distances are measured orthogonally
to opposing edge points and the opening maximum is determined from this,
i.e. the biggest distance between the straight line and an edge point. For better
visualisation you can have the determined opening displayed via two blue lines
("Show results for" option).

Average

The Average distance type determines the value for the average opening
between two object edges. For the measurement one straight help line each is
created for this from the found edge points of the detection areas. The straight
help lines are formed according to the principle of the smallest error squares
(see "Straight line formation", Page 116), with which additional outliers are
ignored to get the straightest possible edge run. Depending on the quality either
the straight help line with the better straightness is used for the measurement
or a straight line of symmetry, which is created from both straight help lines.
From the straight line used all distances are measured orthogonally to opposing
edge points and an average value is calculated from this, which describes the
average opening. For better visualisation you can have the determined average
opening displayed via two blue lines ("Show results for" option).
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Material thickness

The Material thickness distance type determines the smallest distance
(minimum) for each individual edge point to another edge point of the opposing
detection area. It is then checked if all determined distances are within the
set measurement area (distance limits). The smallest found distance and the
biggest found distance of all minima are issued as specific function values. This
distance type is especially suitable for thickness measurement, but it requires a
relatively long processing time.

Filling gaps With the Caliper function gaps that appear with the detection of a straight line
are filled automatically. This only happens for the following distance types:

• Absolute minimum
• Absolute maximum
• Material thickness

With all other functions and distance types there is no automatic or linear filling.
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Steps for setting up
the Caliper function

1. Click on the Functions index card in the
tab area and then on Add.

In the selection menu select the Caliper
entry and give the function a name in the
text field below it. Confirm with OK.

The function appears in the function list
and the parameters area is shown.

2. Move and scale the detection areas (see "Detection area", Page 45) so
that they optimally surround the two edges between which the distance is
to be measured. Ensure that as few interference edges as possible are in
the detection areas.
Check your adjustments via the preview.

3. Specify the direction of the gray value
intersection under Edge transition.
Adjust the direction of the detection arrow
accordingly. Note that both arrows must
point to the same gray value intersection.

4. Adjust the following parameters to your requirements:

• Edge filter value
• Edge contrast
• Edge completeness
• Noise edge filter - Only first edge
• Noise edge filter - Remove short edges
• Noise edge filter - Next to line only

Check your settings via the preview.

5. Under Distance type select the distance
to be measured.



metimus 1.7.0.6
Part 3 – Introduction to Functions and Function Reference

© Vision & Control GmbH
2018

999.994.424.10-en-1.0 89

6. In the camera image window activate the
result display under Show results for –
Selected function.

7. Click on the Single test button to test the parameter settings.

a) If applicable edges have been found, the result value of the measure-
ment is shown and the distance found is shown in blue.

b) If no object edges or unwanted edges are found, correct the corre-
sponding parameters (see step 4) and/or the detection areas (see step
2). Then click on Single test again to check your changes. Repeat this
step as often as necessary.

8. Define the lower and upper distance
range via the values entry. Use the func-
tion result of the Single test from step 7 for
this.

9. Click on the Single test button to check the set distance rangeand to find
out if the function will be displayed as successful. 

6.2.8 Measure angle

Introduction The Measure angle function determines the angle between two object edges.
You select the edges via two detection areas, in which the individual edge
points are detected. A straight line (see "Geradenbildung"), which then
represents the respective object edge, is created from each of the edge
points for the tracking. After a test the edge points found are marked blue
in the camera image. The dashed/dotted angle arc between the detection
areas shows whether the inner or the outer angle between the object edges is
measured. The position of the detection areas is critical here.

Under the display option Show results for - selected function (see "Camera
Image", Page 32) you can have blue help lines displayed for the measurement
results, which visually show you the measured angle and the straight help lines
for the edge recognition. The Measure angle function is successful within a
test process when the found angle is within a tolerance range defined by you
(angle limits). It is especially suitable for quality control on parts with complex
geometry.

Parameters Edge transition

Via a drop-down menu you can specify here whether the gray value within the
detection area is to increase or decrease in the detection direction, so that an
edge point can be detected. The following two settings are possible:
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• Bright → Dark With this setting only edge points on the intersections from
bright to dark gray values in the detection direction are detected and found.

• Dark → Bright With this setting only edge points on the intersections from
dark to bright gray values in the detection direction are detected and found.

The detection direction is an important factor for these parameters. You can find
any object edge with both possible settings if you change the detection direction
accordingly. Note, however, that the edge intersections cannot be individually
adjusted for each detection area.

Edge filter size

Here you specify the accuracy of the line-by-line contour searches using a
sliding controller. The setting ranges from 0 (sharp edge) to 9 (fuzzy edge). The
coarser the filter value the more lines are pooled with the search, so that, under
certain circumstances, fine object edges can no longer be precisely detected.
A high filter setting does actually find more precise edges, but it also requires
a longer processing time for it. From filter value 2 upwards the sub-pixeling
(interpolation-calculation between the pixels) is activated to achieve higher
accuracy. Essentially you require both wide, fuzzy edges and a filter to achieve
greater accuracy.

Edge contrast

You enter the differential amount here, which is the least there must be in the
image with a gray value intersection so that an edge point can be found. The
edge contrast functions here as another filter, which sorts out all edges that
are not considered edge points because of their contrast, and therefore further
restricts the detection of an object edge. The settable value must be within the
gray value scale (1 ... 255) and the contrast ratios of the image are adjusted
so that an object edge can be successfully detected. With small brightness
differences (contrasts) in the image only edges with a lower edge contrast can
therefore be found.

A simplified example: If a dark object (gray value: 5) is against a bright
background (gray value: 212), then the edge contrast may not be set higher
than the differential amount 212 - 5 = 207, so that the object's edges can be
found. If you set the edge contrast to 220, the edge points and therefore the
object with its edges will not be found. If the gray value of the background
changes because of an adjusted lighting to 86, the edge contrast may not
exceed 86 - 5 = 81, so that the object is still found.



metimus 1.7.0.6
Part 3 – Introduction to Functions and Function Reference

© Vision & Control GmbH
2018

999.994.424.10-en-1.0 91

Edge completeness

Here you enter the minimum percentage of image lines that at least one edge
point must have so that an object edge is detected. You can consequently
specify how closed and therefore clear an edge must be in the image to be
detected as an applicable object edge. Pixel gaps, which can be caused by
possible image interferences between individual edge points, can also be
compensated and replaced with a certain tolerance. The edge completeness
always refers to the complete detection window. A measurement is also
performed if the detection window is partially outside the image. In this case
however, the edge completeness decreases according to how much of the
window is outside the image.

For better evaluation and error searches the calculated edge completeness
will be issued after every test process (Single test or Test all) in the results
window under the measurement results. If the specified edge completeness is
not achieved with a function the following message appears under the value
– "Error: The edge completeness is below the reference value." and the test
process has failed.

Noise edge filter - First edge only

If you activate this checkbox the algorithm searches through every line of
the detection area until it finds the first object edge that corresponds with
the set parameters. If there are numerous interfering edges in the detection
area, this filter reduces the processing time significantly. If you deactivate the
checkbox, all edge points that apply for the existing parameters are detected
and processed.

Noise edge filter - Remove short edges 

If you activate this checkbox, individual edge points or smaller edges are
automatically ignored and filtered out. This interference filter is active by default.

Angle range

Here you specify the upper and lower angle limits in [°] and therefore define
the angle range within which the measured angle must lie, so that the function
is rated as successful. With an angle found to be above or below these limits,
the function is considered to have failed. To specify the angle limits you can
raise the angle range with the red and green balls. To do this click on a ball and
move it in the direction you want with pressed mouse button. The blue marking
in the ring then shows the angle range covered. A direct value entry with the
parameters "From / To" is also possible in the two value fields. The settable
values are between -180.00 and 359.9°.
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Preview

In the preview you see the effect of the currently defined parameters and
specified detection areas at all times. The left window always shows the
detection area on the furtherest left here (furthest up with the same vertical
alignment). In both windows the detection area is shown black and is in front
of a blue background. Within the detection areas found edge points (gradients)
are shown in white (good edge contrast) to dark gray (bad edge contrast). They
point to the position where the gradient exceeds the edge contrast. If these
edge points correspond with the edge contrast parameters and are not sorted
out here by one of the interference filters, they are marked green. This means
that these edge points are applicable with a test process. The green marking
identifies the found edge points and entire edges here, to clearly show the
detected position with coarser edge filter settings. Edge points that are sorted
out by an interference filter are marked red and are not applicable with a test
process. The edge completeness parameter does not have any effect on the
display in the preview.

You can activate/deactivate the preview at all times by setting a checkmark with
Show preview. Deactivation reduces the time for parametering, as the device
does not have to generate a new preview for every adjustment.

Use the preview to optimise your parameter settings and to make the test
process more precise. If, for example, you increase the edge filer value, the
effect is immediately visible in the preview – sharp, white edges become
coarser and washy – and you can immediately see whether the edge to be
detected has been detected yet and at the right position. The selection and
strength of the filter depends on the respective object edge.
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Steps for setting up
the Measure angle
function

1. Click on the Functions index card in the
tab area and then on Add.

In the selection menu select the Measure
angle entry and give the function a name
in the text field below it. Confirm with OK.

The function appears in the function list
and the parameters area is shown.

2. Move and scale the detection areas (see "Detection area", Page 45) so
that they optimally surround the two edges between which the angle is to
be measured. Ensure that as few interference edges as possible are in the
detection areas.
Check your adjustments via the preview.

3. Specify the direction of the gray value
intersection under Edge transition.
Adjust the direction of the detection arrow
accordingly. Note that both arrows must
point to the same gray value intersection.

4. Adjust the following parameters to your
requirements:

• Edge filter value
• Edge contrast
• Edge completeness
• Noise edge filter - First edges only
• Noise edge filter - Remove short

edges

Check your settings via the preview.
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5. In the camera image window activate the
result display under Show results for –
Selected function.

6. Click on the Single test button to test the parameter settings. 

a) If applicable edges have been found, the determined angle is issued
and the object edges found are coloured blue and extended.

b) If no object edges or unwanted ones are found, correct the corre-
sponding parameters (see step 4) and/or the detection areas (see step
2). Then click on Single test again to check your changes. Repeat this
step as often as necessary.

7. Define the upper and lower angle range
via the sliding controller or values entry.
Use the function result of the Single test
from step 6 for this.

8. Click on the Single test button to check the set angle limits and to find out
if the function will be displayed as successful. 

6.2.9 Edge rotation

Introduction The Edge rotation function determines the angle between an object edge
and a reference line. The reference line is a defined, fixed determined object
edge, which you can rotate and align in any way you want. Note! The reference
line is tracked. You select the edge to be detected via a detection area that
can be moved to the reference line, in which the individual edge points are
detected. A straight line (see "Geradenbildung"), which then shows the object
edge, is created from the edge points. After a test the edge points found are
marked blue in the camera image. The dotted/dashed angle arc shows whether
the inner or the outer angle is currently being measured. The position of the
elements is critical here.

Under the display option Show results for - selected function (see "Camera
Image", Page 32) you can have blue help lines displayed for the measurement
results, which visually show you the measured angle and the straight help
lines for the edge recognition. The Edge rotation function applies within a
test process when the found angle is within a tolerance range defined by you
(angle range). It is especially suitable for quality control on parts with complex
geometry.

Parameters Edge transition

Via a drop-down menu you can specify here whether the gray value within the
detection area is to increase or decrease in the detection direction, so that an
edge point can be detected. The following two settings are possible:
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• Bright → Dark With this setting only edge points on the intersections from
bright to dark gray values in the detection direction are detected and found.

• Dark → Bright With this setting only edge points on the intersections from
dark to bright gray values in the detection direction are detected and found.

The detection direction is an important factor for these parameters. You can find
any object edge with both possible settings if you change the detection direction
accordingly. Note, however, that the edge intersections cannot be individually
adjusted for each detection area.

Edge filter size

Here you specify the accuracy of the line-by-line contour searches using a
sliding controller. The setting ranges from 0 (sharp edge) to 9 (fuzzy edge). The
coarser the filter value the more lines are pooled with the search, so that, under
certain circumstances, fine object edges can no longer be precisely detected.
A high filter setting does actually find more precise edges, but it also requires
a longer processing time for it. From filter value 2 upwards the sub-pixeling
(interpolation-calculation between the pixels) is activated to achieve higher
accuracy. Essentially you require both wide, fuzzy edges and a filter to achieve
greater accuracy.

Edge contrast

You enter the differential amount here, which is the least there must be in the
image with a gray value intersection so that an edge point can be found. The
edge contrast functions here as another filter, which sorts out all edges that
are not considered edge points because of their contrast, and therefore further
restricts the detection of an object edge. The settable value must be within the
gray value scale (1 ... 255) and the contrast ratios of the image are adjusted
so that an object edge can be successfully detected. With small brightness
differences (contrasts) in the image only edges with a lower edge contrast can
therefore be found.

A simplified example: If a dark object (gray value: 5) is against a bright
background (gray value: 212), then the edge contrast may not be set higher
than the differential amount 212 - 5 = 207, so that the object's edges can be
found. If you set the edge contrast to 220, the edge points and therefore the
object with its edges will not be found. If the gray value of the background
changes because of an adjusted lighting to 86, the edge contrast may not
exceed 86 - 5 = 81, so that the object is still found.
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Edge completeness

Here you enter the minimum percentage of image lines that at least one edge
point must have so that an object edge is detected. You can consequently
specify how closed and therefore clear an edge must be in the image to be
detected as an applicable object edge. Pixel gaps, which can be caused by
possible image interferences between individual edge points, can also be
compensated and replaced with a certain tolerance. The edge completeness
always refers to the complete detection window. A measurement is also
performed if the detection window is partially outside the image. In this case
however, the edge completeness decreases according to how much of the
window is outside the image.

For better evaluation and error searches the calculated edge completeness
will be issued after every test process (Single test or Test all) in the results
window under the measurement results. If the specified edge completeness is
not achieved with a function the following message appears under the value
– "Error: The edge completeness is below the reference value." and the test
process has failed.

Noise edge filter - First edge only

If you activate this checkbox the algorithm searches through every line of
the detection area until it finds the first object edge that corresponds with
the set parameters. If there are numerous interfering edges in the detection
area, this filter reduces the processing time significantly. If you deactivate the
checkbox, all edge points that apply for the existing parameters are detected
and processed.

Noise edge filter - Remove short edges 

If you activate this checkbox, individual edge points or smaller edges are
automatically ignored and filtered out. This interference filter is active by default.

Angle range

Here you specify the top and bottom angle limits in [°] and therefore define the
angle range within which the measured angle must lie, so that the function is
rated as successful. With an angle found to be above or below these limits,
the function is considered to have failed. To specify the angle limits you can
raise the angle range with the red and green balls. To do this click on a ball and
move it in the direction you want with pressed mouse button. The blue marking
in the ring then shows the angle range covered. A direct value entry with the
parameters "From / To" is also possible in the two value fields. The settable
values are between -180.00 and 359.9°.
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Preview

In the preview you see the effect of the currently defined parameters and the
specified detection area at all times. The detection area is shown black and is
in front of a blue background. Within the detection area found edge points are
shown in white (good edge contrast) to dark gray (bad edge contrast). If these
edge points correspond with the edge contrast parameters and are not sorted
out here by one of the interference filters, they are marked green. This means
that these edge points are applicable with a test process. The green marking
identifies the found edge points and entire edges here, to clearly show the
detected position with coarser edge filter settings. Edge points that are sorted
out by an interference filter are marked red and are not applicable with a test
process. The edge completeness parameter does not have any effect on the
display in the preview.

Use the preview to optimise your parameter settings and to both speed up and
make the test process more precise. If, for example, you increase the edge filer
value, the effect is immediately visible in the preview – white edges become
coarser and washy – and you can immediately see whether the edge to be
detected has been detected yet and at the right position.
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Steps for setting up
the Edge rotation
function

1. Click on the Functions index card in the
tab area and then on Add.

In the selection menu select the Edge
rotation entry and give the function a
name in the text field below it. Confirm
with OK.

The function appears in the function list
and the parameters area is shown.

2. Move and scale the detection area (see "Detection area", Page 45) so
that it optimally surrounds the edge to be detected. Then position the refer-
ence line. Ensure that as few interference edges as possible are in the
detection area.
Check your adjustments via the preview.

3. Specify the direction of the gray value
intersection under Edge transition.
Adjust the direction of the detection arrow
accordingly.

4. Adjust the following parameters to your
requirements:

• Edge filter value
• Edge contrast
• Edge completeness
• Noise edge filter - First edge only
• Noise edge filter - Remove short

edges

Check your settings via the preview.
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5. In the camera image window activate the
result display under Show results for –
Selected function.

6. Click on the Single test button to test the parameter settings.

a) If applicable edges have been found, the determined angle is issued
and the object edges found are coloured blue and extended.

b) If no object edges or required object edge are not found, correct the
corresponding parameters (see step 4) and/or the detection area (see
step 2). Then click on Single test again to check your changes. Repeat
this step as often as necessary.

7. Define the upper and lower angle range
via the sliding controller or values entry.
Use the function result of the Single test
from step 6 for this.

8. Click on the Single test button to check the set angle range and to find out
if the function will be displayed as successful. 

6.2.10 Measure circle

Introduction The Measure circle function measures the radius of a circle or a circular
contour. Via a detection area in the shape of a circular ring or circular ring
segment you can select the circle you want and detect the individual edge
points. After a test the edge points found are marked blue in the camera image.
Both the average radius (distance type "average") and the maximum/minimum
radius (distance type "all circle points") of the circle can be measured. The
determined result values must then be within a defined tolerance range so that
the function is rated as successful.

With the display option Show results for - selected function (see "Camera
Image", Page 32) after the function is tested you can have the circle found and
the radius displayed visually.

Parameters Edge transition

Via a drop-down menu you can specify here whether the gray value within the
detection area is to increase or decrease in the detection direction, so that an
edge point can be detected. The following two settings are possible:

• Bright → Dark With this setting only edge points on the intersections from
bright to dark gray values in the detection direction are detected and found.

• Dark → Bright With this setting only edge points on the intersections from
dark to bright gray values in the detection direction are detected and found.
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The detection direction is an important factor for these parameters. You can find
any object edge with both possible settings if you change the detection direction
accordingly. Note, however, that the edge intersections cannot be individually
adjusted for each detection area.

Edge filter size

Here you specify the accuracy of the line-by-line contour searches using a
sliding controller. The setting ranges from 0 (sharp edge) to 9 (fuzzy edge). The
coarser the filter value the more lines are pooled with the search, so that, under
certain circumstances, fine object edges can no longer be precisely detected.
A high filter setting does actually find more precise edges, but it also requires
a longer processing time for it. From filter value 2 upwards the sub-pixeling
(interpolation-calculation between the pixels) is activated to achieve higher
accuracy. Essentially you require both wide, fuzzy edges and a filter to achieve
greater accuracy.

Edge contrast

You enter the differential amount here, which is the least there must be in the
image with a gray value intersection so that an edge point can be found. The
edge contrast functions here as another filter, which sorts out all edges that
are not considered edge points because of their contrast, and therefore further
restricts the detection of an object edge. The settable value must be within the
gray value scale (1 ... 255) and the contrast ratios of the image are adjusted
so that an object edge can be successfully detected. With small brightness
differences (contrasts) in the image only edges with a lower edge contrast can
therefore be found.

A simplified example: If a dark object (gray value: 5) is against a bright
background (gray value: 212), then the edge contrast may not be set higher
than the differential amount 212 - 5 = 207, so that the object's edges can be
found. If you set the edge contrast to 220, the edge points and therefore the
object with its edges will not be found. If the gray value of the background
changes because of an adjusted lighting to 86, the edge contrast may not
exceed 86 - 5 = 81, so that the object is still found.

Edge completeness

Here you enter the minimum percentage of image lines that at least one edge
point must have so that an object edge is detected. You can consequently
specify how closed and therefore clear an edge must be in the image to be
detected as an applicable object edge. Pixel gaps, which can be caused by
possible image interferences between individual edge points, can also be
compensated and replaced with a certain tolerance. The edge completeness
always refers to the complete detection window. A measurement is also
performed if the detection window is partially outside the image. In this case
however, the edge completeness decreases according to how much of the
window is outside the image.
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For better evaluation and error searches the calculated edge completeness
will be issued after every test process (Single test or Test all) in the results
window under the measurement results. If the specified edge completeness is
not achieved with a function the following message appears under the value
– "Error: The edge completeness is below the reference value." and the test
process has failed.

Noise edge filter - First edge only

If you activate this checkbox the algorithm searches through every line of
the detection area until it finds the first object edge that corresponds with
the set parameters. If there are numerous interfering edges in the detection
area, this filter reduces the processing time significantly. If you deactivate the
checkbox, all edge points that apply for the existing parameters are detected
and processed.

Noise edge filter - Remove short edges 

If you activate this checkbox, individual edge points or smaller edges are
automatically ignored and filtered out. This interference filter is active by default.

Noise edge filter - Edges next to circle only

Here you can define a both-sided distance from the main contour, outside of
which all found edge points are ignored and not displayed as function results.
You can consequently remove irrelevant and measurement error-causing edge
points, to receive exact and clear measurement results. The distance can be
entered via a values field in [mm].

Radius range

Via the two value entries lower and upper you can specify the tolerance limits
in [mm] here, and therefore define the measurement area, within which the
measured radii must be so that the function is rated successful. With a radius
found to be above or below these limits, the function is considered to have
failed.

Radius type

Via the drop-down menu you specify the distance types to be measured here.
The two types All circle points and Average can be selected. You will find
descriptions for individual types in the following "Distance types" section.
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Preview

In the preview you see the effect of the currently defined parameters and the
specified detection area at all times. The detection area is shown black and is
in front of a blue background. Within the detection area found edge points are
shown in white (good edge contrast) to dark gray (bad edge contrast). If these
edge points correspond with the edge contrast parameters and are not sorted
out here by one of the interference filters, they are marked green. This means
that these edge points are applicable with a test process. The green marking
identifies the found edge points and entire edges here, to clearly show the
detected position with coarser edge filter settings. Edge points that are sorted
out by an interference filter are marked red and are not applicable with a test
process. The edge completeness parameter does not have any effect on the
display in the preview.

Use the preview to optimise your parameter settings and to both speed up and
make the test process more precise. If, for example, you increase the edge filer
value, the effect is immediately visible in the preview – white edges become
coarser and washy – and you can immediately see whether the edge to be
detected has been detected yet and at the right position.

Distance types All circle points
The All circle points distance type determines the minimum and the maximum
radius of a circular contour. A circle is created from the detected edge
points (see "Kreisbildung zur Berechnung eines Referenzkreises aus einer
Punktwolke") and a circle centre point is therefore defined. The distance
between the found edge points and the circle centre point is then measured
with the measurement. This produces a minimum radius (smallest distance) and
a maximum radius (biggest distance). Both values are issued as results and
visualized, and must be within the tolerance range (radius limits).

Average
The Average distance type determines the mean radius of a circular contour.
A "best" circle is created from the detected edge points (similar to straight
line formation, see "Kreisbildung zur Berechnung eines Referenzkreises aus
einer Punktwolke") and a circle centre point is therefore defined. The distance
between the (best) circle and the circle centre point is then measured and
issued as result value.
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Steps for setting up
the Measure circle
function

1. Click on the Functions index card in the
tab area and then on Add.

In the selection menu select the Measure
circle entry and give the function a name
in the text field below it. Confirm with OK.

The function appears in the function list
and the parameters area is shown.

2. Move and scale the detection area (see "Detection area", Page 45) so
that it optimally surrounds the contour to be detected. Ensure that as few
interference edges as possible are in the detection area.
Check your adjustments via the preview.

3. Specify the direction of the gray value
intersection under Edge transition.
Adjust the direction of the detection arrow
accordingly.

4. Adjust the following parameters to your requirements:

• Edge filter value
• Edge contrast
• Edge completeness
• Noise edge filter - First edges only
• Noise edge filter - Remove short edges
• Noise edge filter - Next to circle only

Check your settings via the preview.

5. Under Radius type select the radius type
to be measured.
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6. In the camera image window activate the
result display under Show results for –
Selected function.

7. Click on the Single test button to test the parameter settings. 

a) If an applicable circular contour has been found the result values of the
measurement are displayed accordingly. The best circle found is also
shown in blue and the radius is drawn in.

b) If no contour or an unwanted one is found, correct the corresponding
parameters (see step 4) and/or the detection area (see step 2). Then
click on Single test again to check your changes. Repeat this step as
often as necessary.

8. Define the lower and upper radius range
via the value entry. Use the function result
of the Single test from step 6 for this.

9. Click on the Single test button to check the set radius limits and to find out
if the function will be displayed as successful. 

6.3 Output

Introduction

With the I/O Manager in the Output tab field you can typify test results and
assign the output assignments. Own output signals can therefore be defined
for specific combinations of function results, which can then control a PLC via
digital outputs. All settings are transparently combined and listed in a table. The
table's white fields can be edited, i.e. they can be changed with a mouse click.

Types Using Types you can assign different overall results to a fixed type, which is
also assigned its own output assignment for the digital outputs. To do this you
give the types specific conditions, which an overall result must meet to comply
with the respective type. If an overall result applies to several types, the best
concurring type will be selected.

The assignment is based on the results of the individual functions of Test all,
i.e. if the respective functions were successful or failed. The conditions must
all be met so that a result can be assigned to a type. Under the Functions
table line all functions of the program are listed, while the columns on the right
contain the individual types. In the white fields by clicking on the field you can
specify whether a specific function for a type must be

a) successful ( + ),
b) failed ( - ),
c) no influence (   )
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so that the test part is assigned to it. You will also find the individual values
under the table in the legend. The column with the Other type is for cases in
which the results of a test could not be assigned to a type and therefore cannot
be changed either (e.g. if Test all failed).

You will find the assignment of the digital outputs under the Output table line. It
can also be set by clicking. A H here stands for a high level and L for a low level
on the respective output (OUT). If an overall result has been assigned to a type,
the set level here is on the outputs. In the Save measured values and Save
images lines you can also specify if the same is to be saved for a type (Yes/No)
or if a type is to be removed in the Delete type line.

You add/delete a type as follows

• To add a type click on Add type.

The new type (type 2, type 3, etc.) appears in the table.

• To delete a type click in the Delete type line on the field of the respective
type.

You set up a type as follows

1. Adjust function conditions: Left click
in the shared function and type field and
consequently go on to the next step.
The order of the values is ( + ) → ( - ) →
(   ) → ( + ) → ( - ) → (   ), etc.

2. Adjust output assignment: Left click in
the shared output (OUT) and type field
and consequently go on to the values ( H )
and ( L ).

3. Save measured values: Click in the
measured values line on the type field and
consequently switch between the options
( Yes ) and ( No ). 

4. Save images: Click in the "Images" line
on the type field and consequently switch
between the options ( Yes ) and ( No ).
The user interface must be connected with
a vision system for this.

Save settings

You can specify the format that you want to save the images in on the "Output"
tab. Under Image format used you can select between *.jpg, *.bmp and
*.png. It must be ensured here that the images are saved in the *.bmp format
uncompressed and loss-free; in the *.jpg format compressed but lossy; and in
the .png format compressed and loss-free. If you select the *.jpg format you
can set the image quality in the JPG quality  value field using the compression
rate. Under Number of images to be saved you can specify the maximum
number of images to be saved for a type. When this number has been reached
the saved images are individually overwritten by the last pictures taken (starting
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with the oldest images). The images are stored in the archiving directory under
Tools - UI Options. A subfolder is created here with the name of the program.
The image files are named according to the name of the program, the assigned
type and the date and time at which the picture was captured.

Measured values are saved in a *.csv file in the same directory as the images
and can be opened with a table calculation program. Playback into the results
display is also possible (see "Log", Page 34). With the *.csv file import ensure
that the characters are UTF8-coded. You will find more on this in the annex, see
see "Description of the measured value file", Page 112.

Send results

All functions of the currently active program are listed in the output list with
name, type and function ID. You can select the function that the results are to
be sent for via the RS232 interface by checking the box in front of the function
name. The result of Test all (with type and duration, etc.) is sent when you
select the "Overall result" entry.
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7 PART 4 - APPENDICES

7.1 External program change and trigger

Program change via
digital inputs/outputs

You can change programs directly via the digital inputs and outputs. To do this,
assign PLC IDs to your programs (see "Program manager", Page 20) so that
you can call the programs via the digital interface.

Since the BV systems differ in the number of digital inputs and outputs, the
terms INX and OUTX are used for the highest available inputs and outputs
(INX, X=5 means: 6 available inputs) in the following description. The inputs and
outputs are numbered from 0, where IN0 is reserved for the trigger and OUT0
for the ready signal.

Direct program change

With the direct change you can control a limited number of programs. It is
calculated as follows: n=2(INX-IN0)-2.

ADVICE
No subsequent test cycle takes place during a program change. If the
program to be switched to corresponds to the currently executed program, a
test cycle is executed.

1 Apply the bit pattern for the PLC ID of the program to the inputs IN1 to INX,
whereby the highest bit must be at input IN1.

2 Release the trigger (IN0).

° If the change is detected, the vision system checks whether the program
exists and switches to the new program. Then OUT1 is set and a ready
signal (OUT0) is applied. The success of the change can be queried
via OUT1. A high indicates a successful change, at low the change was
faulty.

ADVICE
If a program exists but has data errors, the vision system loads the program
that was active before the change. If this fails too, an empty program is
created. This also applies to program changes via bit shifting.

Program change via bit shifting

All PLC IDs can be controlled with bit shifting.

ADVICE
In contrast to the direct program change, the current program is also reloaded
from the flash memory when changing via bit shifting.

1 Apply a high signal to the inputs IN1 to INX and release the trigger (IN0).

° The vision system confirms the initiated program change with a high
signal at OUT1 and a released ready signal (OUT0).
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2 Leave the IN1 at high and create the corresponding PLC ID in bits ("shift
in") at the inputs IN2 to INX. The bits are appended below, i.e. the first bits
created are the most significant. Within the applied bits (IN2 to INX), IN2 is
the highest bit. With the trigger signal (IN0) you accept the values from IN2
to INX, whereupon OUT1 is set to high and the ready signal respectively. As
long as the PLC ID shift continues, IN1 must remain high.

3 If the PLC ID is complete, set IN1 to low and trigger (IN0).

° If the program exists, the vision system switches to the desired program.
If the change is successful, OUT1 is set to high, otherwise to low. Finally,
a ready signal is applied (OUT0).

° To trigger an image acquisition with the vision system again, you must set
IN1 to INX to low.

Trigger and program
change via the
process interface

test all via trigger

With the trigger command (0x01) you can trigger an image acquisition. After
receiving a trigger pulse, the trigger command is confirmed and after completion
of the image acquisition the evaluation (test all) is started.

Query

32 Bit 0x01 Command for trigger

Reply

32 Bit 0x01 Repeating the trigger
command

32 Bit Good/Bad 0=OK, 1=Error (e.g.
image acquisition via the
user interface is deacti-
vated)

Program change

Via the program change command (0x02) and the corresponding PLC ID you
can switch to a specific program. You can define the PLC ID, for example, in
program management (see "Program manager", Page 20). After receiving the
command, the reply is sent as to whether the change was successful. The
system is triggerable again after sending the response.

Query

32 Bit 0x02 Command for program
change

32 Bit PLC ID PLC ID of the program

Reply

32 Bit 0x02 Repeat program change

32 Bit Good/Bad 0=OK; 1=not allowed;
2=Program not found; 3=
Error during loading (Flash
or program data)
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7.2 Format of the transmitted measured data

Introduction The measured values sent to external modules via the 3964R, ASCII and binary
protocols are available in a specific format. They are divided into individual
blocks of measured values, which consist of a general header and the function-
dependent data. All measured values are transmitted as 32-bit integers. You
can choose between image and world coordinates as parameters.

Structure of the
measured value
blocks - General
Header

32 Bit 0x00 Marking as block of measured values

32 Bit PLC ID PLC ID of the program, configurable

32 Bit Function ID internally determined; -1 for overall result

32 Bit Function type Type of function
0 = Overall Result
1 = Area Test
2 = Brightness Percentage
3 = Gray Value Test
4 = Pattern Search
5 = Caliper
6 = Measure Angle
7 = Locate Corner
8 = Edge Position
9 = Edge Rotation
13 = Measure Circle
15 = Locate Circle

32 Bit Result 0 = good
1 = bad
2 = failed (calculation not possible)
3 = test range is outside of the image
4 = invalid parameter

Structure of the
measured value
blocks - Function-
dependent data

0 = Overall Result

32 bit Type Number of the type, 0 = type Default

32 bit Counter Test number, increased by 1 for each test

1 = Area Test

32 bit Area Number of pixels (image coordinates)
µm2 x 1000 (world coordinates)

2 = Brightness Percentage

32 bit Brightness
Percentage

Proportion of bright pixels in per thousand
(image and world coordinates)

3 = Gray Value Test

32 bit Gray Value 0 to 255
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4 = Pattern Search

32 bit Match in per mille

32 bit Position X

32 bit Position Y

see coordinate system

32 bit Angle in degrees*100, between -18000 and +17999
clockwise (image coordinates)
in degrees*1000 (world coordinates)

5 = Caliper

32 bit Measuring
method
(distance type)

0 = AbsoluteMaximum
1 = AbsoluteMinimum
2 = OpeningMinimum
3 = OpeningMaximum
4 = Average
5 = AllWithinTolerance (material thickness)

For measuring method 0 - 4 follows:

32 bit Distance in pixels (image coordinates)
in μm (world coordinates)

For measuring method 5 follows:

32 bit Minimum
distance

in pixels (image coordinates)
in μm (world coordinates)

32 bit Maximum
distance

in pixels (image coordinates)
in μm (world coordinates)

6 = Measure Angle

32 bit Angle in degrees*100, between 0 and + 35999 (image
coordinates)
in degrees*1000 (world coordinates)

7 = Locate Corner

32 bit Position X

32 bit Position Y

see coordinate system

32 bit Angle in degrees*100, between -18000 and +17999
clockwise (image coordinates)
in degrees*1000 (world coordinates)
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8 = Edge Position

32 bit Measuring
method
(distance type)

2 = OpeningMinimum
3 = OpeningMaximum
4 = Average
5 = AllWithinTolerance (material thickness)

For measuring method 2 - 4 follows:

32 bit Distance in pixels (image coordinates)
in μm (world coordinates)

For measuring method 5 follows:

32 bit Minimum
distance

in pixels (image coordinates)
in μm (world coordinates)

32 bit Maximum
distance

in pixels (image coordinates)
in μm (world coordinates)

9 = Edge Rotation

32 bit rotation angle in degrees*100, between 0 and + 35999 (image
coordinates)
in degrees*1000 (world coordinates)

13 = Measure Circle

32 bit Measuring
method
(radius type)

4 = Average
5 = AllWithinTolerance (all circle points)

For measuring method 4 follows:

32 bit Radius in pixels (image coordinates)
in μm (world coordinates)

For measuring method 5 follows:

32 bit Minimum radius in pixels (image coordinates)
in μm (world coordinates)

32 bit Maximum radius in pixels (image coordinates)
in μm (world coordinates)

15 = Locate Circle

32 bit Position X

32 bit Position Y

see coordinate system



metimus 1.7.0.6
Part 4 - Appendices

112 999.994.424.10-en-1.0 © Vision & Control GmbH 2018

Parameter -
Coordinate system

Conversion between image coordinates and world coordinates.

Value Image coordinate World coordinate

Coordinate (Posi-
tion)

Pixel (origin upper left
corner)

Micrometer (origin image
center)

Angle Degree * 100 Degree * 1000

Gray Value Gray value (0 to 255) Gray value (0 to 255)

Percentages
(correspondence,
brightness)

Per mille ‰ Per mille ‰

Area Pixel number Square micrometers * 1000

Type Type number Type number

7.3 Description of the measured value file

The history file (*.csv) contains all measured values of the total and individual
tests and can be imported with a spreadsheet program.

ADVICE
UTF-8 is used as the character set.

The columns are separated by a semicolon " ; ".

The decimal point " . " (English format) is used as the decimal separator.

Structure of the table Column Description

1 "$FileVersion2$" as version identifier (without quotation marks)

2 Program name

3 Name of the associated image (blank if no image is saved)

4 Date and time of recording (local time according to ISO 8601)

5 Overall result (FALSE = bad, TRUE = good)

6 Type (0 = no type, -1 for single test)

7 Target type

8 Total execution time [µs]

9 - x Function entries
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Structure of the table -
Function entries

Column Description

9 Function type as number
1 = Area Test
2 = Brightness Percentage
3 = Gray Value Test
4 = Pattern Search
5 = Caliper
6 = Measure Angle
7 = Locate Corner
8 = Edge Position
9 = Edge Rotation
10 = Calibrate via Caliper
11 = Calibrate via Edge Position
13 = Measure Circle
14 = Calibrate on a Circle
15 = Locate Circle
2046 = Calibrate via Image Field Size

10 Function name

11 Good/Bad of this function (TRUE/FALSE)

12 Execution time of this function [µs]

13 Number of the following function results (depending on the function)

14 - x Functional results (depending on function)

Structure of the table -
Functional results

Type 1 Area Test

1. Number of counted pixels [Pixel]

2. Area of counted pixels [mm²]

Type 2 Brightness Percentage

1. Brightness [%]

Type 3 Gray Value Test

1. Gray value [0 bis 255]

Type 4 Pattern Search

1. X value of the found position [Pixel]

2. Y value of the found position [Pixel]

3. X value of the found position [mm]

4. Y value of the found position [mm]

5. Rotation angle of the found object [°]

6. Degree of match of the object found [%]

Type 5 Caliper

• for two results

1. Distance [mm]

2. Edges found [%]

• for three results (distance type material thickness)
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1. Minimum distance [mm]

2. Maximum distance [mm]

3. Edges found [%]

Type 6 Measure Angle

1. Angle [°]

2. Edges found [%]

Type 7 Locate Corner

1. X value of the found position [Pixel]

2. Y value of the found position [Pixel]

3. X value of the found position [mm]

4. Y value of the found position [mm]

5. Rotation angle [°]

6. Edges found [%]

Type 8 Edge Position

• for two results

1. Distance [mm]

2. Edges found [%]

• for three results (distance type material thickness)

1. Minimum distance [mm]

2. Maximum distance [mm]

3. Edges found [%]

Type 9 Edge Rotation

1. Angle [°]

2. Edges found [%]

Type 10 Calibrate via Caliper

1. Distance [Pixel]

2. Pixel size in X direction [mm]

3. Pixel size in Y direction [mm]

4. Edges found [%]

Type 11 Calibrate via Edge Position

1. Distance [Pixel]

2. Pixel size in X direction [mm]

3. Pixel size in Y direction [mm]

4. Edges found [%]

Type 13 Measure Circle

• for two results



metimus 1.7.0.6
Part 4 - Appendices

© Vision & Control GmbH
2018

999.994.424.10-en-1.0 115

1. Distance [mm]

2. Edges found [%]

• for three results

1. Minimum radius [mm]

2. Maximum radius [mm]

3. Edges found [%]

Type 14 Calibrate on a Circle

1. Radius [Pixel]

2. Pixel size in X direction [mm]

3. Pixel size in Y direction [mm]

4. Edges found [%]

Type 15 Locate Circle

1. X value of the found position [Pixel]

2. Y value of the found position [Pixel]

3. X value of the found position [mm]

4. Y value of the found position [mm]

5. Edges found [%]

Type
2046

Calibrate via Image Field Size

1. Pixel size in X direction [mm]

2. Pixel size in Y direction [mm]

7.4 Start parameters description

You can use extendable start parameters to specify that the user interface is
executed with a predefined and/or unchangeable interface by default.

After installation you will find a link in the start menu with changed start
parameters: Vision & Control metimus - Monitoring. This starts the user
interface in the unchangeable "Monitoring" view.

Add start parameters You must define the start parameters in the start link of the user interface. To do
this, right-click on a shortcut of the user interface and choose Properties. Then
click in the Target text box and add the parameters after the file path (ends with
...\metimus.exe"). Separate the parameters from the file path and from each
other with a space. Confirm with Accept and OK.

You can use the following start parameters:
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Syntax Description

--view=[view
name]

Specifies one of the preset views as start view. For [view
name] enter the name of the preset view you want (without
brackets): "Standard", "Monitoring", "Automatic test
series", "Calibration".

--disableView-
Menu

Deactivates the "View" menu and therefore prevents any
changes to the interface and the set view.

Example (full line):
"C:\Program Files (x86)\Vision & Control\metimus\metimus.exe" --
view="Monitoring" --disableViewMenu

7.5 Algorithm description

7.5.1 Straight line formation

Straight line formation To determine a line from a set of points, the method of the smallest error
squares from all points is used. The following step in a loop iteratively improves
the straight line and reduces interferences (breakouts in the edge). (Depending
on the set of points up to 4 iterations).

1. Determination of the average distance of the points to the straight line.

2. Sort out the points with an "above-average" distance - If more than half of
the calculation points are sorted out, the tolerance is increased so that not
too many points are eliminated.

3. Form a new line using the smallest error squares from the remaining points.

7.5.2 Circle formation

Calculation of a
reference circle from a
scatter plot

The reference circle is calculated from a scatter plot as follows:

1. Segmentation (division) of the circle ring element (detection element) into 3
individual segments.

These segments ensure that the points for the calculation are not directly
beside one another.

1st segment

2nd segment 3rd segment

2. In the first sweep a randomly selected point is taken from each segment and
added to a sample, consisting of 3 points.
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1st segment

2nd segment 3rd segment

x
x x x

x

x
x

x
x

xx

x

x
x

x

point 1 from segment 1

point 1 from segment 3point 1 from segment 2

3. This process is repeated several times, whereby new point combinations are
produced from the 3 segments again and again.

4. A radius and a center point are formed for all samples and written to a list.

5. After the segmentation is completed the samples are sorted in the list after
the radius.

6. This is followed by calculation of the final centre point and the radius as
an average of the samples in the immediate environs of the median of the
sorted list.

7.6 Terms used in industrial image processing

Exposure time The exposure time is the time that the camera is made light-sensitive for. This
time is set electronically in industrial cameras. (Shutter).

Contrast In "image processing" terms this is the gray value difference between the
brightest and the darkest pixels in the whole image or in a restricted area.
High-contrast pictures are a prerequisite for successful image processing,
because image processing algorithms "live" off contrast. If the picture is too
dark, this will result in a low contrast. An over-lit image also has a low contrast
and there is the possibility that errors are overexposed and therefore cannot be
detected. The best contrast is achieved when the entire spread of the possible
gray values (at 8 bit 256) is used for the image. A low contrast reduces the
achievable accuracy, and the reliability in recognising details.

Image 28: Various contrast ratios
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# Description

1 Test object

2 Recording area

3 Optimum contrast

4 Good contrast

5 Bad contrast

Table 4: Figure details - Various contrast ratios

Object size The object size provides the maximum enlargement of the test object, which is
registered by the system. It is determined by the camera and the optical set-up.

Image 29: Various object sizes

# Description

1 Test object

2 Recording area

3 Optimum object size

4 Good object size

5 Recording area too small

Table 5: Figure details - Various object sizes

Pixels Word made up from "picture" and "element". Defines a picture point on the
camera, or on a monitor etc., with line and column coordinates x, y, among
others.

Gray value Term for the brightness value of a pixel. With 8-bit cameras the minimum gray
value (0) is reached with absolute darkness and the maximum gray value
(255) identifies saturation. The gray value is proportional to the product from
exposure time and illumination intensity for the individual pixels of the camera.
The illumination intensity is proportional to the object brightness.
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Gray value range Describes the maximum and minimum limits between which the determined
gray values will be considered. The gray value range information is used by
some image processing functions, such as area test, for example.

Image 30: Pixels and gray value

# Description

1 Area with gray value 255

2 Area with gray value 0

3 Area with gray value 255

4 Area with gray value 150

5 Digital image *

6 Pixels

* Matrix with X lines and Y columns; matrix elements are called pixels; matrix
values from 0 (black) to 255 (white);   a pixel value is called a gray value

Table 6: Figure details - Pixels and gray value

Threshold value The threshold value provides the criterion for separating a value area (gray
values, colour values) into two subsets. Thresholds are used for binarising
images (binary threshold), among other functions. A histogram analysis is used
here to calculate the optimum threshold. Thresholds can be fixed, variable
(dynamic threshold), apply to the entire image (global threshold), or just to
image sections (local threshold).
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7.7 Testpattern

You can cut out the testpattern and use it as a setup aid for your device.

Image 31: Testpattern as setup aid
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